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Chapter 1 — Introduction 

Program ATLAS was developed to analyze the survival of smolts migrating 

downstream in the Columbia River Basin using acoustic- and radio-tagging data. 

Active tagging technologies allow increased flexibility in designing survival studies 

but also introduces the problem of tag failure. Tag failure can be the result of 

mechanical or battery failure and cannot be distinguished from mortality in release-

recapture studies. Therefore, the perceived survival estimates (the probability of a 

fish and tag being “alive”) must be adjusted for the probability of tag failure to 

obtain an unbiased survival estimate. 

Program ATLAS has five modes of operation corresponding to five study 

designs: 

1. Single Release,  

2. Paired Release, 

3. Virtual/Paired Release, 

4. Virtual Release with Dead Fish Correction (ViRDCt) – full, and 

5. Virtual Release with Dead Fish Correction (ViRDCt) – reduced. 

Chapter 2 describes the ATLAS user interface. Chapter 3 describes how to 

perform analyses with Program ATLAS as it pertains to all study designs. See 

Chapter 4 for details on the Single-release mode, Chapter 5 for the paired-release 

mode, Chapter 6 for the virtual/paired-release mode, Chapter 7 for the full Virtual 

Release with Dead Fish Correction (ViRDCt) mode, and Chapter 8 for the reduced 

ViRDCt mode. 

This manual describes Program ATLAS version 1.12. The latest version of the 

software, along with a .pdf copy of this manual, is available on the Columbia Basin 

Research website on the Columbia Basin Research ATLAS page.  

http://www.cbr.washington.edu/analysis/apps/atlas
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Chapter 2 — ATLAS User Interface 

When running Program ATLAS for the first time, an initial splash screen 

appears followed by the initial dialog for study design selection as shown in Figure 

2.1. To skip this window on subsequent runs, uncheck the check box in the lower 

right corner of the dialog. The ability to change the default study design is still 

available under the Edit menu at the top of the main window. 

 
Figure 2.1: Initial dialog for study design selection. 

Once the desired study design is selected, press the Continue button to open 

the main window. Figure 2.2 shows Program ATLAS upon initial startup in Single 
Release mode. 
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Figure 2.2: Program ATLAS at initial startup in single-release mode. 

The main window (for all study designs) consists of the following components: 

• The ATLAS Menu (i.e., the system of drop-down menus) provides alternative 

access to the commands on the navigation panel as well as many general 

setting commands for the ATLAS program. 

• The Navigation Panel on the left side is a hierarchical list of available 

actions for the user to take. Actions not currently available are grayed out. An 

action is initiated by double clicking on it. 

• The Status Report Panel on the right side gives the current program state. 

At initial startup, it simply shows that there are no capture history data 

loaded. 

• The Tag Life Data Report below the status report panel shows which tag-life 

data have been loaded, the tag-life curve associated with each tag-life data, 

and the truncation count for each. 
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• The Output along the bottom is where status messages, warnings, and 

errors are reported as actions are performed. 

• The Workspace with the colored background is where all subsequent reports 

and dialogs appear. 

Any of the above (except the Workspace) can be hidden by clicking the “close 

window” (X) icon on the right of their respective title bars or via the View menu. 

They can also be unhidden via the View menu. Figure 2.2 shows the default 

positions of the main window components. The positions can be changed by 

dragging their title bars to a new position on the window or dragging them 

completely outside of the Program ATLAS window. 

As shown in Figure 2.2 there is a system of drop-down menus across the top 

of the ATLAS main window. All the menu commands echo those available via the 

Navigation Panel and are described in later sections. Others are available only via 

the ATLAS Menu; these are described in this section.  

Accessibility features: The ATLAS Menu provides navigation through ATLAS’s 

features and modeling process using the keyboard rather than the mouse. Access a 

specific menu or option using the “alt” key combined with the letter indicated for the 

selection. Navigate within menu and reports using the arrow keys or the tab key. 

Check boxes can be selected using the keyboard by tabbing until the check box is 

highlighted and then clicking the space bar. 

2.1 File Menu 

The File menu is shown in Figure 2.3. The top section echoes file-related 

commands available on the navigation panel. At the bottom the Exit command 

causes the ATLAS program to exit. The middle section contains commands for 

saving and printing reports and graphs. They are available only when a plot or 

report is being displayed. These commands are described as follows: 
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• Save As saves the current report or graph to a selected output file. Reports 

are saved in Rich Text Format (.rtf), and graphs are saved in Portable 

Network Graphics format (.png). For the .png files, the dimensions of the 

output can be specified via the Settings dialog (Section 2.2.1.1).  

• Print Preview simply gives a preview of the output. 

• Print prints the current report or graph to the selected printer. 

• Exit leaves the program. 

 

Figure 2.3: The File menu. 

2.2 Options Menu 

The Options menu is shown in Figure 2.4. 
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Figure 2.4: The Edit menu. 

• Change Study Design allows the user to switch from one study design 

(single-release, paired-release, virtual/paired-release, full ViRDCt, reduced 

ViRDCt) to another. When selected, ATLAS will prompt for the desired study 

design. Changing the study design will cause all loaded data and current 

settings to be lost. 

• Settings is described below in Section 2.2.1. 

• Disable Tag Life Correction is a checkable item that allows the user to 

disable tag-life corrections. This allows the user to analyze mark-recapture 

data that did not use active tags or do not have data available from a tag-life 

study for use in estimating tag-life corrections. 

• Clear Data removes all currently loaded data (capture history and tag-life 

data) from ATLAS. 

• Factory Reset removes all currently loaded data and changes all settings to 

the initial settings that came with the program.  

2.2.1 Settings 

When the Settings option is selected from the Edit menu, the Settings dialog 
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appears with three main tabs available: (1) Reports, (2) Graphics, (3) 

Bootstrapping, (4) Capture Histories, and (5) Optimizer. 

2.2.1.1 Reports Settings 

Figure 2.5 shows the Settings dialog with the Reports tab selected. This 

option allows the user to change the level of precision displayed in all reports. The 

precision for the point estimates is editable separately from the precision for the 

standard error estimates. 

   

Figure 2.5: The Reports dialog under Settings. 

2.2.1.2 Graphics Settings 

Figure 2.6 shows the Settings dialog with the Graphics tab selected. This 

allows the user to change the size of any graphs saved with the Save As command 

and is set via a desired pixel size. 
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Figure 2.6: The Graphics dialog under Settings. 

2.2.1.3 Bootstrapping Settings 

The Bootstrapping tab (Figure 2.7) allows the user to set the number of 

bootstrap iterations for both the tag-life bootstrapping and the full variance 

bootstrapping (Section 3.3.3, Appendix B.2.1). The default and recommended value for 

both is 1000. The user is also given the option of changing these settings when 

performing the actual bootstrapping.  
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Figure 2.7: The Bootstrapping dialog under Settings. 

2.2.1.4 Capture Histories Settings 

Figure 2.9 shows the Capture Histories tab of the Settings dialog. The only 

choice in this Settings tab is listed under the Capture History Report and includes 

a checkbox to Exclude captures histories with zero counts from any analysis if 

the user wishes to do so. Clicking this box affects only the capture histories that are 

reported in the Capture History Report; all capture histories, including those with 

zero counts, are used to fit the model. 
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Figure 2.8: The Capture Histories dialog under Settings. 

2.2.1.3 Optimizer Settings 

Figure 2.9 shows the Optimizer dialog. Optimizer is used to numerically 

maximize the likelihood and thus calculate the parameter estimates, as described in 

Appendix B. Four optimizers are available: 

1. Fletch, 

2. Quasi-Newton (FBSG), 

3. Direction Set (Powell’s), and 

4. Simplex. 



 

11 
 

 

Figure 2.9: The Optimizer dialog under Settings. 

Experience suggests that Fletch, which is a quasi-Newton optimizer, is the 

best choice in ATLAS. More information about the others can be found in Press et 

al. (2007). 

2.3 Captures Histories, Attributes, Tag Life Data, Closed 
Form Estimates, and Modeled Estimates Menus 

Figure 2.10 shows the ATLAS Menu and corresponding actions available in 

the Navigation Panel. These two operational routes allow users to navigate by 

either mouse or keyboard commands. These Atlas Menu options are defined 

further in this manual in the sections listed below and are as follows: 

• Capture Histories (alt-c) contains all the functions under Capture Histories 

in the Navigation Panel: 

o Load Capture Histories (Section 3.1), 

o Define Release Groups (Section 3.1.1), 
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o Select Downstream Sites (Section 3.1.3), 

o View Mixing (Section 3.1.2), 

o View ViRDCt Mixing (Section 3.1.2), and 

o Reports (Section 3.1.4). 

• Attributes (alt-a) mimics the Navigation Panel functions and allows for 

loading in an optional attributes file (Load Attributes, Section 3.2) and then 

selecting pertinent attribute values for analysis (Select Attributes, Section 

3.2). 

• Tag Life Data (alt-t) matches the functionality found on the Navigation 
Panel and includes: 

o Load Tag Life Data (Section 3.3), 

o Fit Tag Life Curves (Section 3.3.1), 

o Map Tag Life Data to Bins (Section 3.3.2), 

o Calculate Tag Life Corrections (Section 3.3.3), and 

o View Tag Life Corrections (Section 3.3.4). 

• Closed Form Estimates (alt-l) mimics the Navigation Panel and includes 

Parameter Estimates and Cumulative Survival Estimates (Section 3.4.1). 

• Modeled Estimates (alt-m) contains all functionality of its Navigation Panel 
twin, including: 

o Equate Parameters (Section 3.4.2.1), 

o Constrain Parameters (Section 3.4.2.2), 

o Compute (Section 3.4.2), 

o Compute Full Variance (Section 3.4.3), and  

o Reports (Section 3.4.4), including: 

 Parameter Estimates, 

 Cumulative Estimates, 

 Survival Covariance, and 
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 Generate Reports. 

  

Figure 2.10: The ATLAS Menu and corresponding actions available in the 
Navigation Panel. 

2.4 View, Window, and Help Menu Settings 

Figure 2.11 shows the View menu. It simply allows the user to display or hide 

various components of the ATLAS main dialog, as described above, by checking or 

unchecking the associated entry. 
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Figure 2.11: The View menu. 

Figure 2.12 shows the Window menu. This menu allows users to either Tile 
Windows, Cascade Windows, or Close All open windows. Tile Windows 

arranges all generated windows in non-overlapping grids to fill the screen space. 

Cascade Windows stacks windows diagonally, showing only their title bars to reduce 

clutter while keeping them easily accessible.  Choosing Close All will close all 

previously generated windows. 

 

Figure 2.12: The Window menu. 
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Figure 2.13 shows the Help menu, where users can find a brief About dialog, 

Check for Updates, or Configure Updates. 

 

Figure 2.13: The Help menu. 
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Chapter 3 — Analysis with ATLAS 

At initial startup, the only actions available on the Navigation Panel are 

Load Capture History Data under the Capture History Data heading, and 

Load Tag Life Data under the Tag Life Data heading. Capture history data are 

required to do any analysis, and tag-life data are required if taking into account tag 

failure. Optionally, after the tag-life data are loaded, the user can load an attribute 

group file that allows analysis of subsets of the capture history data. 

The five main sections under the navigation panel are as follows: 

• Capture Histories (Section 3.1) is for loading and examining the capture 

history data, and for configuring the sites and releases to be used in the 

analysis, 

• Attributes (Section 3.2) defines one or more attributes (e.g., tagger, tag lot) 

and assigns tag codes to attribute values that can be selected or deselected 

in the analysis, 

• Tag Life Data (Section 3.3) allows the user to load the tag-life data, fit the 

tag-life curves, and estimate the resulting tag-life corrections, and 

• Closed Form Estimates (Section 3.4.1) and Modeled Estimates (Section 

3.4.2) are where the survival probabilities are estimated. 

3.1 Capture Histories 

The capture history data file contains the detection history for each tagged 

individual in each release group in the study. Details of this file are given in 

Appendix A.1—it is typically created by the TagPro utility app available on the 

Columbia Basin Research website. In order to load the capture history data, double 

click on Load Capture History Data on the Navigation Panel and select the 

capture history data file to be loaded. 

https://www.cbr.washington.edu/analysis/apps/tagproapp
https://www.cbr.washington.edu/analysis/apps/tagproapp
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3.1.1 Define Release Groups 

ATLAS distinguishes between the idea of a “release” and that of a “release 

group.” A release consists of tagged individuals released from the same site at 

about the same time and is designated within the capture history data file by 

grouping tags together under a user-specified release name. A release group, on 

the other hand, defines the collection of tags to be modeled using common survival 

and detection probabilities in the relevant release-recapture model during analysis. 

Each study design, other than the single-release study design, uses multiple 

release groups. Additionally, some study designs allow multiple releases to be 

grouped together to define the release group used in analysis. All releases included 

in a single-release group will be used to estimate a common set of survival and 

detection probabilities. The use of the release group structure in ATLAS allows 

users to pool individual releases from within the program, without having to rename 

them in the input data file.  

Once the capture history data file has been loaded into ATLAS, the individual 

releases are listed in the Status Report window under Releases. The types of 

release groups allowed are determined by the selected study design and consist of 

either individual releases or else pooled releases. Clicking on Define Release 
Groups opens a window to allow the user to select to which release group an 

individual release will be assigned. This enables creating larger release groups from 

within ATLAS or reassignment of a group if the default selection is not correct. The 

specifics of the Define Release Groups dialog are described in Sections 4.2 and 4.3 

for single-release studies, Section 5.1 for paired-release studies, Section 6.1 for 

virtual/paired-release studies, and Sections 7.1and 8.1 for ViRDCt studies. 

3.1.2 View Mixing and View ViRDCt Mixing 

The View Mixing action is applicable to the paired-release and virtual/paired-

release study designs. Section 5.3 discusses the View Mixing function for a paired-

release study design and 6.3 for a virtual/paired-release study design. The View 
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Mixing function is not applicable to the ViRDCt study designs because the 

downstream release is extended throughout the study. 

The View ViRDCt Mixing action is available only for the Full ViRDCt or Reduced 

ViRDCt study designs. Discussion of the View ViRDCt Mixing function is available in 

Section 7.2 for the full ViRDCt study design. The mixing plot for the reduced ViRDCt 

design is similar.  

3.1.3 Select Downstream Sites 

Select the Select Downstream Sites action to bring up the Active Sites 

dialog. The Active Sites dialog for a single-release study is shown in Figure 3.1. 

Note that the first two sites are listed as Required. This is because a minimum of 

two downstream sites are required for a single-release study; the number of 

required downstream sites is a function of the study design. In the data for Figure 

3.1, there are four optional sites downstream for a total of six sites. By default, the 

check boxes for the optional sites are selected, meaning they will be included in the 

analysis. If a user deselects a site, all sites downstream of the site will be 

deselected as well and will not be included in analysis. Conversely, if a user selects 

an unselected site, all upstream sites are selected as well. Note that the Apply 

button must be pressed for any changes to take effect. In Figure 3.1, only the first 

two of the four optional sites are selected; this defines the data set used in the rest 

of this chapter.  
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Figure 3.1: Active Sites selection dialog for a single-release study with six 

downstream sites, four of which are used in modeling. 

3.1.4 Reports 

The following reports are available under Reports in Capture Histories on the 

Navigation Panel once the capture history data file has been loaded: 

• Capture History Report, 

• Cormack-Jolly-Seber (CJS) Report, 

• CJS Cumulative Survival Report (single release only), and  

• CJS Survival Covariance Report (single release only). 

3.1.4.1 Capture History Report 

An example of a Capture History Report is shown in Figure 3.2. A capture 

history is a symbolic representation of the detection history of an individual fish: “1” 
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indicates detection without removal at a site, “0” indicates no detection, and “2” 

indicates detection and removal (i.e., the tag’s detection data are censored at this 

event to remove detections that should no longer be included in the study, for 

example after known removal, physical rehandling, etc.). The capture history reads 

from left to right with the first field representing the most upstream site and the 

final field representing the most downstream site. In the example in Figure 3.2, six 

fish in the “Roosevelt Chinook” release have a capture history of “1 1 0 1,” 
meaning that they were detected at the first two sites, not detected at the third 

downstream site, and detected again at the final downstream site. 

 

Figure 3.2: A portion of a Capture History Report. 

If there are six or fewer downstream sites, all possible capture histories are 

included in the capture history report; for seven or more sites, only capture histories 

that were observed in the given release are included. 
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3.1.4.2 CJS Report 

Figure 3.3 shows a Cormack-Jolly-Seber (CJS ) Report for a study with one 

release named “Roosevelt Chinook.” There is one line per release in both the 

survival estimates table and the capture estimates table. The derivation of the 

survival estimates and the capture estimates can be found in Burnham et al. 

(1987). 

The Survival Estimates in the CJS Report are only perceived survival 

estimates. They are not corrected for tag failure and thus represent the combined 

probability of fish survival and tag survival. 

 

Figure 3.3: Cormack-Jolly-Seber Report for a single-release study. 

3.1.4.3 Cormack-Jolly-Seber Survival Cumulative Report 

The CJS Cumulative Survival Report, available in single-release mode only, 

gives the cumulative survival estimate to each site. Figure 3.4 shows the CJS 
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Cumulative Survival Report for the same capture history data as in Figure 3.3. 

The survival from release to the first site is the same in each report; the survival 

from release to the second site in Figure 3.4 is the product of the survival 

probabilities in Figure 3.3: 0.8926 × 0.9396 = 0.8387. 

 

Figure 3.4: Cormack-Jolly-Seber Cumulative Survival Report for a single-

release study. 

3.1.4.4 CJS Survival  Covariance Report 

The covariance matrix for the CJS survival estimates, available in single-

release mode only, allows the user to calculate the variance of a function of the 

survival estimates. The values are reported in full precision via the CJS 
Covariance Report, and the user can readily copy and paste the table into a 

spreadsheet. An example is shown in Figure 3.5. 
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Figure 3.5: CJS Survival Covariance Report. 

3.2 Attributes 

ATLAS 1.12 allows the user to load an optional attribute group file, providing 

the analysis of a subset of the data. The details of the attribute group file are given 

in Appendix A.2. 

Once the attribute group file is loaded, the user can double click on Select 
Attributes on the navigation panel to bring up the Attribute Group Selection 

dialog as shown in Figure 3.6. If multiple attributes are present (i.e., such as 

release size or time, each in a separate column), the user can select the attribute of 

interest at the bottom of the dialog as shown in Figure 3.6. By default, all attribute 

values are selected. When a subset of the attributes is selected, all further 

analysis will use only the tags that have the selected attribute values. If a 

combination of attributes is desired (e.g., large size at release combined with 

morning release time), a separate column in the attributes file will be required that 

assigns a unique code to the possible factor combinations. 
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Figure 3.6: Attribute Group Selection dialog for an attribute file with two 

attributes. 

3.3 Tag Life Data 

In order to obtain independent estimates of the tag-life correction probabilities, 

a representative sample of tags from the study must be set aside and the failure 

time of each tag must be recorded. These failure times are recorded in the tag-life 

data file as described in Appendix A.3. ATLAS 1.12 allows for the use of multiple 

tag-life files. 

Multiple tag-life files may be necessary when multiple tag bins are used with 

different failure time curves or when tags are released under differing protocols. For 

example, multiple tag-life files would be necessary for a paired-release study if all 

tags were activated at the same time for the upper and lower releases but tags in 

the lower release were held longer before release than tags in the upper release; 

this would provide more opportunity to observe a tag failure for the lower release 

tags and result in a different tag-failure model. To load tag-life data, double click on 
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Load Tag Life Data and select the desired tag-life data file. Repeat for each tag-

life data file to be loaded. Figure 3.7 shows the navigation panel after two tag-life 

data files have been loaded. 

 

Figure 3.7: Navigation Panel after loading two tag-life files. 

3.3.1 Fit Tag-life Curves 

In order to estimate the tag corrections, the form of the failure time model 

(Tag Life Function) must be selected to model the tag failure for each tag-life file. 

Program ATLAS provides four types of failure time models to choose from: 

1. the Non-Parametric estimator, also known as the Kaplan-Meier estimator 

(Kaplan and Meier 1958), 

2. the Weibull 2-parameter distribution, 

3. the Weibull 3-parameter distribution, or 

4. the Vitality survival function (Li and Anderson, 2009, see also the Vitality 

Model page on the Columbia Basin Research site). 

When the user selects the Fit Tag Life Curve action, the Tag Life dialog opens as 

shown in Figure 3.8. The points on the plot represent the data from the tag-life data file 

(Appendix A.3); the X-axis is time in days, and the Y-axis is the proportion of tags still 

functioning at a given time. At the bottom of the dialog shown in Figure 3.8, the user first 

selects the current Tag Life Dataset of interest and then selects the type of failure time 

model (Tag Life Function) to model the tag failure for that dataset. Once selected, 

ATLAS immediately estimates the parameters for the tag-life curve and plots the 

http://www.cbr.washington.edu/vitality
http://www.cbr.washington.edu/vitality
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resulting curve in red, allowing the user to review the model fit and select the failure 

curve that best fits the tag-life data. Figure 3.8 shows the vitality survival function 

fitted to the tag-life dataset named “tagLife_data.” The user must click Apply to 

finalize the tag life function selection. 

 

Figure 3.8: Tag Life selection dialog. 

Along the top of the Tag Life dialog are three tabs. The first one, Tag Life 
Data vs Curve, is the default when the Fit Tag Life Curve action is initiated, 

because selecting the Tag Life Function is always the first step (Figure 3.8). Once 

the appropriate function has been selected, the user may select either the Curve 
vs Data by Detection tab or the Curve vs Data by Release tab. Both these tabs 

allow the user to view the arrival timing of individuals as a function of the selected 

tag-life curve. 
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3.3.1.1 Curve vs Data by Detection 

Figure 3.9 shows the Tag Life dialog with the Curve vs Data by Detection tab 

selected. It allows the user to select a detection site of interest for the currently 

selected tag-life dataset. The plot will show the arrival timing distribution for all 

releases that  were released upstream of the selected site superimposed on the 

selected tag-life curve. If a given release arrives at a site beyond the range of the 

tag-life curve, the user may want to consider excluding the release from analysis. 

 

Figure 3.9: Tag-life curve with arrival time distributions at a selected site. 

3.3.1.2 Curve vs Data by Release 

Figure 3.10 shows the left portion of the Tag Life dialog with the Curve vs 
Data by Release tab selected. On this tab, the user selects the release group of 

interest and the plot shows the arrival distribution for that release group at all 



 

28 
 

downstream detection sites. If a selected release arrives too far down the tag-life 

curve, the user may need to consider either excluding the release from analysis or 

excluding the relevant detection site, along with all sites further downstream.  

 

Figure 3.10: Tag-life curve with arrival time distributions for a selected release 

group.  

3.3.1.3 Truncating Tag-Life Data 

In a well-designed study, the tag detections will occur well before the majority of 

tag failures used to fit the tag-life curve, falling on the flat area of the curve rather than 

toward the tail of the curve (see Figure 3.9 and Figure 3.10). In some cases, outlier tags 

in the tag-life study may exert undue influence on the parameter estimation for the tag-

life curve, resulting in a biased prediction of tag survival at the times of tag detection. 

This happens when some tags in the tag-life study last much longer than the rest. 

Figure 3.11 shows simulated tag-life data with two outliers that failed more than 20 days 
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after the previous tags failed. Although no fish were detected at this tail end of the 

curve, the outliers may strongly affect estimation of the tag-life curve and thus the tag-

life corrections. The user has the option of removing the outliers from being considered 

in estimating the tag-life curve parameters. Figure 3.12 shows the same simulated data 

with the last two tags removed. Notice how much better the estimated curve fits the 

data. 

 

Figure 3.11: Tag-life curve with simulated data with outliers. 
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Figure 3.12: Tag-life curve after outliers have been excluded from the truncated 

analysis. 

3.3.2 Map Tag Life Data to Bins 

Sometimes it is necessary to use different tag corrections for different groups 

of tags in the study. For example, if the tags came from more than one 

manufacturing lot, then it may be necessary to use a separate tag-life curve for 

each manufacturing lot. In these cases, the user must provide unique tag-life 

datasets for each manufacturing lot and tell ATLAS which tag-life datasets should 

be used for fitting each tag-life curve by assigning tag-life datasets to bins, and the 

ATLAS capture history file must identify the appropriate bin for each tag released. 

The TagPro utility can be used to assign tag codes to bins. Within ATLAS, the 

user must then map each bin to a tag-life dataset. This is done by double clicking 

on Map Tag Life Data to Bins, which brings up the Map Tag Life Data to Bins 

dialog. In the example in Figure 3.13, there are two tag bins for the tags used in this 
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study as identified in the capture history data file. The user has loaded two tag-life 

datasets: “ tagLife_1” and “tagLife_2.” The user has associated the tag-life curve for 

tagLife_1 to bin 1, and the tag-life curve for tagLife_2 to bin 2. All tags in a single 

tag-life dataset must be assigned to the same bin, and more than one tag-life dataset 

can be mapped to the same bin. All bins must be assigned a tag-life dataset.  

 

Figure 3.13: Dialog for mapping tag-life curves to tag bins. 

There may be reasons for dividing the tags into multiple bins other than 

manufacturing lots. For example, if there was a significantly longer time between 

tag activation and release for some tags than for others, it may be desirable to put 

the tags with the longer hold times in a separate bin.  
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Although a given release may consist of tags from multiple bins, thus requiring 

separate tag-life correction estimates, all tagged fish from the release are assumed 

to share the same survival and detection probabilities. In other words, unique tag-

life corrections are estimated for each bin, but the survival and capture parameter 

estimates apply to an entire release group. 

3.3.3 Calculate Tag Correction Table 

After selecting the tag-life curve, and mapping tag bins to tag-life curves if 

necessary, the user can then estimate the tag-life corrections by double clicking on 

Calculate Tag Life Corrections. The user will then be asked to enter the number 

of iterations for the bootstrapping process. The default is 1000, which is the 

recommended value. Increasing the number of iterations increases the precision of 

the variance estimates but also increases the time it takes to perform the 

bootstrapping process. The details of the bootstrapping are given in Appendix 

B.2.1. 

In some instances, especially with the ViRDCt models, the data may be too sparse 

to calculate the tag-life correction variances. In that case, the Compute Full Variance 

option will not be available. Instead, the variances will be based only on the inverse 

Hessian and will be underestimated. 

3.3.4 View Tag Life Correction Table 

After the probabilities of a tag being active at the downstream detection 

sites have been calculated, the user may double click on the View Tag 
Corrections to view the tag-life correction estimates. Figure 3.14 shows a portion 

of a Tag Correction Report for the virtual/paired-release study design using a 

common tag-life curve applied across all releases. 
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Figure 3.14: Example of a Tag Correction Report table for a virtual/paired-

release study. 

3.4 Analysis: Closed Form Estimates and Modeled 
Estimates 

Program ATLAS provides two methods for estimating survival parameters 

corrected for tag life: (1) closed-form estimates, available under Closed Form 
Estimates and (2) Modeled Estimates on the Navigation Panel. Only the 

modeled estimates are available for the full ViRDCt study design. 

3.4.1 Closed Form Estimates 

Figure 3.15 shows the top portion of the Closed Form Parameter Report 
for a single-release study. It is structured the same as the CJS Report (Section 

3.1.4.2) but it differs in that the survival estimates are corrected for tag life; the 

reported survival estimates are the CJS estimates divided by the tag correction. 
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Note that all estimates and standard errors under the Capture Detail section of 

the report are the same as those on the CJS Report. 

 

Figure 3.15: Example of a Closed Form Parameter Report for a single-

release study. 

For the paired-release study design and the virtual/paired-release study 

design, the Closed Form Parameter Report will also report the paired-release 

survival estimate or estimated dam passage survival, respectively (Sections 5.4 and 

6.4). The Closed Form Parameter Report is not available for the full ViRDCt study 

design. See Appendix B.2.1 for details on calculating the estimates and the 

corresponding standard errors. 

For a single-release study design, a Closed Form Cumulative Survival 
Report is available as well and is analogous to the CJS Cumulative Survival 
Report (Section 3.1.4.3). 

Note that the Closed Form Parameter Report is not available if any of the 
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releases has more than one bin associated with it. Also, for the single-release 

model and the reduced ViRDCt model, the Closed Form Parameter Report is not 

available if there is more than one upstream release 

3.4.2 Modeled Survival Estimates 

Although the Closed Form Parameter Report adjusts the survival 

probabilities for tag failure, the standard errors reported on the Closed Form 
Parameter Report represent only the variance from the release-recapture model 

and omit the portion of the variance that arises from the tag-life model. Additionally, 

the Closed Form Parameter Report does not allow the user to either equate 

parameters across release groups or constrain survival and detection probabilities, 

both of which may be necessary either to calculate appropriate parameter estimates 

or to attain the optimal precision. Finally, the Closed Form Parameter Report is 

not available for some study designs, such as the full ViRDCt study design. The 

actions under the Modeled Estimates address these issues.  

Under Modeled Estimates, Program ATLAS uses numerical optimization to 

calculate the Maximum Likelihood Estimates (MLE) of the model parameters. For 

the single release, paired release, and virtual/paired-release study design, Program 

ATLAS models each release (including virtual releases) with a single-release 

likelihood as described in Appendix B.2.1; for the ViRDCt study design, Program 

ATLAS models the live and dead releases with a joint-release likelihood as 

described in Appendices B.2.4 and B.2.5. These likelihood models incorporate the 

tag-life corrections treated as known constants within the likelihood function. Once 

the tag corrections have been computed, the user may simply double click on the 

Compute action on the navigation panel to compute the maximum likelihood 

estimates. The output of the optimizer is displayed in the output window, an 

Estimation Complete message will appear, and the Parameter Estimates 

report will be available on the navigation panel. The Compute action performs two 

steps via numerical methods: 
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1. Estimate the parameters 

2. Estimate the covariance matrix and thus the standard errors of the 

parameters 

Either of these steps can fail due to sparse data or due to survival or capture 

probabilities at or above 1.0. In order to deal with this, the user may have to 

constrain parameters as explained in Section 3.4.2.2. 

3.4.2.1 Equate Parameters Across Releases 

The closed-form estimates (Section 3.4.1) assume that each release group in 

a study design has unique parameters. The same is true of the modeled 

estimates if the default settings are used when Compute is performed. Given the 

fact that study designs with multiple release groups are designed so that the 

release groups encounter the same conditions downstream, this approach may be 

overly conservative. The Equate Parameters Across Releases action via Equate 
Parameters on the Navigation Panel allows the user to have Program ATLAS 

assume common survival and detection probabilities across releases. Reducing the 

number of parameters in the model may increase the precision of the resulting 

survival estimates. 

Figure 3.16 shows the Equate Parameters Across Releases dialog for a 

paired-release study. Selecting a check box tells Program ATLAS to assume a 

common parameter across releases for survival or detection at the particular site 

or for the final product. 



 

37 
 

 

Figure 3.16: Equate Parameters Across Releases dialog for a paired-release 

study. 

Selecting a site for survival or detection causes all downstream sites to be 

selected as well; conversely, deselecting a site causes all upstream sites to be 

deselected as well. The parameters that can be equated vary for each study 

design; hence, the Equate Parameters Across Releases dialog will look different 

for each study design. 

In Figure 3.16, the user has chosen to equate all detection parameters across 

releases and equate the final product parameter across releases. The Apply button 

must be pressed for these selections to take effect the next time Compute is 

pressed. 

Figure 3.17 shows the Modeled Parameter Report from a paired-release 

study with no parameters equated across releases. Figure 3.18 shows the 

parameter report with the detection and lambda parameters equated across 

releases for the same data. The parameter reports show both the maximized 

log-likelihood values and the number of parameters in the model, allowing the 

user to perform a Likelihood Ratio Test (LRT) to test whether or not it is valid to 

equate the parameters. The LRT statistic in this example is 2(– 39.7235 – (–

40.7096)) = 1.9723. The degrees of freedom are the difference in the number of 

parameters (14 – 10 = 4). The P-value for a χ2 = 1.9723 with 4 degrees of 
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freedom is 0.74, indicating that the parameters can be equated across the two 

releases. Using an LRT in this way to test the validity of equating parameters 

can be done with any study design (except for a single-release study with only 

one release). 

 

Figure 3.17: Modeled Parameter Report with default configuration of no 

parameters equated across releases for a paired-release study. 



 

39 
 

 

Figure 3.18: Modeled Parameter Report with the capture and lambda parameters 

equated across releases for a paired-release study. 

3.4.2.2 Constrain Parameters 

Numerical optimization algorithms require initial seeds for the parameters to be 

estimated. Program ATLAS uses the CJS estimates as seeds for the parameters, 

and it is possible for these estimates to be at or above 1.0. Because of the nature 

of the likelihood function, this can cause the numerical optimizer to be unable to 

estimate the parameters. The Constrain Parameters action allows the user to 

constrain the problematic parameters in order to estimate the remaining parameters 

and the covariance matrix. 

Survival parameters and detection parameters are constrained in different 

ways. Detection parameters may be treated as constants set to 1.0 rather than 

parameters to be estimated, and survival parameters may be constrained using the 

logit function  
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𝑆𝑆 =
𝑒𝑒𝑒𝑒 𝑝𝑝(𝑆𝑆0)

1 − 𝑒𝑒𝑒𝑒 𝑝𝑝(𝑆𝑆0)
(3.1) 

where 𝑆𝑆0 is the parameter to be estimated and 𝑆𝑆 is the resulting survival estimate. 

This allows 𝑆𝑆0 to be any real number while constraining 𝑆𝑆 to be between 0.0 and 

1.0. 

Figure 3.19 shows the output window after double clicking the Compute 

action on the navigation panel with data from a single-release study design (the 

same error message will appear as an error dialog as well). Note that Program 

ATLAS was able to estimate the point estimates but not the covariance matrix, 

thus no results are available. A look at the CJS estimates in Figure 3.20 shows that 

the survival estimate in the first reach is greater than 1.0, which may be the source of 

the problem. Figure 3.21 shows the Constrain Parameters dialog for the same data 

with the Survival tab selected and the initial survival parameter (Release to 

CR275.0) constrained via the logistic function. The rows represent detection sites, 

and the columns represent releases. The CJS estimates are displayed for each 

release and site. The Apply button must be pushed for the specified constraints to 

take effect. 

Once the survival parameter has been constrained, the Compute action is 

selected again, and Figure 3.22 shows the resulting parameter report with the initial 

survival parameter at 1.0.  

 
Figure 3.19: Output window showing covariance estimation error (in red) after the 

Compute action.  
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Figure 3.20: CJS estimates with a survival probability greater than 1.0. 

 

Figure 3.21: Constraining the survival parameter with the logistic function.  
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Figure 3.22: Modeled Parameter Report after constraining the survival probability 

with the logistic function. Compare to Figure 3.20. 

3.4.3 Compute Full Variance 

Once the Compute action has been performed and the MLEs calculated, the 

Modeled Parameter Report is available as shown in Figure 3.22. However, near 

the bottom of the Parameter Report will be the phrase “Note: all standard errors 

are based on only the inverse Hessian.” The Hessian is the matrix of second 

derivatives. Under maximum likelihood theory, the inverse of the Hessian is the 

covariance matrix from which the standard error estimates are derived. This 

covariance matrix is based on the likelihood model. The likelihood model 

necessarily assumes that tag corrections are known without error and does not 

incorporate the standard errors of the tag corrections as reported in the Tag 
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Correction Report. Thus, standard errors that are based only on the inverse 

Hessian will underestimate the true standard errors. 

In order to estimate the full variance of the survival estimates that takes into 

account the variance of the tag corrections, bootstrapping must be performed. The 

details of the bootstrapping are given in Appendix B.2.1. The Compute Full 
Variance action will bring up a dialog asking the user for the number of bootstrap 

iterations. A higher number of iterations will improve the estimate of variance but 

will also take longer to compute. The default is 1,000 bootstrap iterations. 

Once the Compute Full Variance action has completed, the Modeled 
Parameter Report will be updated as shown in Figure 3.23 to reflect the full 

standard errors for all survival parameters (the standard errors for the detection and 

product probabilities remain unchanged). 
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Figure 3.23: Parameter Report after Estimate Full Variance action. 

3.4.4 Reports 

Under the Reports section of the Modeled Estimates heading, three reports 

are available: (1) Parameter Estimates, (2) Cumulative Survival, and (3) 

Survival Covariance. The Modeled Parameter Estimates report has already 

been shown in the previous discussion (e.g., Figure 3.22 and Figure 3.23). The 

Modeled Cumulative Survival Report (Figure 3.24) and the Modeled Survival 
Covariance Report (Figure 3.25) are available only for a single-release study. 

Each report reflects the adjustments for tag-life corrections in the point estimates of 
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survival and any modeling actions performed. If the user has not previously 

performed the Compute Full Variance action, then the standard errors in these 

reports reflect only the uncertainty from the release-recapture data as represented 

by the inverse Hessian. After the user has performed the Compute Full Variance 

action, the standard errors also reflect the uncertainty from the tag-life corrections 

from bootstrapping. However, the covariance report will continue to be based only 

on the inverse Hessian (Figure 3.25). 

A portion of a Modeled Cumulative Survival Report is shown in Figure 3.24. 

It is analogous to the CJS Cumulative Survival Report (Section 3.1.4.3) in that it 

shows survival estimates from release to each site. 

A portion of the Modeled Survival Covariance Report is shown in Figure 

3.25. As with the CJS Survival Covariance Report (Section 3.1.4.4), the values 

are reported in full precision and may be copied and pasted to a spreadsheet for 

custom variance calculations. 

 

Figure 3.24: A portion of a Modeled Cumulative Survival Report for a single-

release study before selecting Compute Full Variance. 
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Figure 3.25: A portion of a Modeled Survival Covariance Report for a single-release 

study. 
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Chapter 4 — Single-release Study 
Design 

This chapter presents details unique to analyzing data from the single-release 

study design. Analysis elements that are common to all study designs are described 

in Chapter 3. 

A single-release study consists of a single release group with multiple 

downstream detection sites. It may be either an actual single-release study with the 

release group consisting of a single release as illustrated in Figure 4.1 or a virtual 

single-release study with a single virtual release composed of fish from multiple 

upstream releases as illustrated in Figure 4.2. Single-release survival can be 

estimated when multiple releases are available in the capture history by selecting 

each release group one at a time.  

 
Figure 4.1: Actual single-release study with K detection sites. 

 

Figure 4.2: Virtual single-release study with K detection sites. 
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4.1 Load Capture History Data 

When the user loads a capture history file in single-release mode, the dialog 

shown in Figure 4.3 appears, forcing the user to select the type of single-release 

study. 

Upon selecting the single-release study type and pressing the Next button, 

the user must next select which releases in the dataset to include in the 

analysis. If the user selected an Actual single-release study, only one release 

group can be selected, as demonstrated in Figure 4.4; if a Virtual single-release 

study was selected, one or more release groups can be selected to form the virtual 

release. 

 
Figure 4.3: Select Release Type dialog in single-release mode. 
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Figure 4.4: Dialog for Selecting Actual Release Group(s) to be used in single-

release study. 

The Next button brings up the review dialog as shown in Figure 4.5. The user 

can then select Finish or Back. As the dialog points out, the user can select 

Define Release Groups after the fact to change the setup. 

 

Figure 4.5: Dialog for reviewing single-release study setup. 
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4.2 Actual Single-release Study Design 

Figure 4.6 shows the status report after loading a capture history file with only 

one release. The status report shows that the single release, in this case named 

“Roosevelt Chinook,” has 2282 tagged individuals. The release group 𝑅𝑅1 is shown 

to consist of the single release, the only option in this case. 

 

Figure 4.6: Status Report after loading data with only one release for an actual single-

release study. 
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4.2.1 Tag Corrections 

Section 3.3.3 describes how to estimate the tag corrections. Figure 4.7 shows 

the Tag Correction Report for an actual single-release study. Each column 

represents the unconditional probability of a tag surviving to the given site from the 

time of tag activation, based on the observed travel times to the site. 

 

Figure 4.7: Tag Correction Report for an actual single-release study. 

4.3 Virtual Single-release Study Design 

As mentioned above, a user may define a virtual release group from multiple 

releases as represented in Figure 4.2. Figure 4.8 shows the status report with all 

three release groups used to define virtual release group “V1.” Under the Releases 

heading, the number tagged in each release is reported. Under the Groups 

heading, the number in each release that was detected at site “A0,” and thus forms 

a part of V1, is reported. 

Figure 4.9 shows the Tag Correction Report for a single-release study with a 
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virtual release composed of three separate releases. Since the first site now 

defines a virtual release, the tag correction table must be interpreted differently than 

in the case of an actual single-release study. The tag corrections in column A0 are 

the unconditional tag survival probabilities from release to site A0. Under the 

subsequent columns, “A1” through “A3” in this case, are the conditional tag 

survival probabilities, given that the tag was alive at site A0. Note that the tag 

corrections under A0 are not used directly in the calculation of the corrected 

survival estimates; they are used to calculate the subsequent downstream tag 

corrections and are displayed in the Tag Correction Report for reference. 

(Warning: All releases included in the virtual release group must be released 
upstream of the first detection site, or tag-life corrections will be incorrect.)  

 

Figure 4.8: Status Report for a virtual single-release study. All three releases are 

used in forming the virtual release V1. 
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Figure 4.9: Example of a Tag Correction Report for a virtual single-release study. 

4.3.1 Closed Form Parameter Report 

Figure 4.10 shows the Closed Form Parameter Report for a virtual single 

release. The Pooled Survival estimates are the weighted average of the survival 

estimates from the Survival Detail section, weighted by release size. 
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Figure 4.10: Closed Form Parameter Report for a single-release study using a virtual 

release. 

4.3.2 Equate Parameters Across Releases 

Figure 4.11 shows the dialog Equate Parameters Across Releases for a 

virtual single release. The user may equate all survival and detection probability 

parameters across releases (except for the “virtual site”), as well as the final product 

parameters.  
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Figure 4.11: Equate Parameters Across Releases with a virtual single release 

with three releases, default setting; note that “CR234.0” is the virtual site. 

4.3.3 Creating a Virtual Release 

In order to pool tags from separate releases to create a virtual release, the 

tagged fish from the disparate release groups should have common survival and 

detection probabilities. The user can test whether or not different releases have 

common survival and detection probabilities using an LRT as described here. This 

test requires first fitting the model using unique parameters for all release groups, 

refitting the model using common parameters, and then comparing the optimized 

likelihood function values from the two model fits. 

Figure 4.12 shows the Parameter Report after performing the Compute 

action with the default settings of no parameters equated across releases (Figure 

4.11). We note the log-likelihood value (-59.7625) and the number of parameters 

(15).  

We then equate all parameters across releases as shown in Figure 4.13, 

perform the Compute action again, and look at the Parameter Report as shown in 

Figure 4.14. The new log-likelihood value is -67.9273 with 5 parameters. The LRT 
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statistic is 2 × (-59.7625 – (-67.9273)) = 16.3296. The degrees of freedom are 

computed as the difference in the number of parameters (10). The P-value for a χ2 

statistic of 16.3296 with 10 degrees of freedom is 1 - 0.91 = 0.09, indicating that it is 

valid to combine these three releases into one virtual release group (using an α 

level of 0.05; the appropriate α level [= maximum acceptable probability of Type I 

error] depends on the context of the study; smaller α levels are recommended for 

careful research, whereas preliminary studies may use higher α levels. ). If the 

result had been different or if a larger α level were desired, we could have 

eliminated one of the releases that seemed to have different survival or detection 

probabilities and repeated the testing process with two releases in the virtual 

release group. Once a model configuration has been chosen and the Compute 

action has been performed, the Compute Full Variance action must be taken to 

obtain the standard errors of the survival estimates, as described in Section 3.4.3. 

 

Figure 4.12: Example of a Parameter Report for a single-release study, no 

parameters equated across releases. 
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Figure 4.13: Equate Parameters Across Releases for a virtual single-release 

study with three releases, all parameters equated. 

 

Figure 4.14: Example of a Parameter Report for a single-release study, all 

parameters equated across releases. 
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Chapter 5 — Paired-release Study 
Design 

This chapter presents details unique to analyzing data from the paired-release 

study design. Analysis elements that are common to all study designs are described 

in Chapter 3. 

A paired-release study consists of two release groups: an upstream release 

group labeled “R1,” and a downstream release group labeled “R2.” The parameter 

of interest, 𝑆𝑆𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃, is the ratio of the survival probabilities in the first reach common 

to the two release groups. Details are given in Appendix B.2.2 

5.1 Define Release Groups 

The capture history data file for a paired-release study must contain two 

releases. By default, the first one is considered the upstream release group (R1), 

and the second one is the downstream release group (R2). Figure 5.1 shows the 

Define Release Groups dialog for a paired-release study with the default 

configuration; the only other option is to switch the roles of the two releases. Figure 

5.2 shows the status report for the default configuration with the release named 

“TDA Chinook” mapped to the R1 release group and “Hood River Chinook” mapped 

to the R2 release group. A minimum of two detection sites are required 

downstream of the initial release. 
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Figure 5.1: Define Release Groups (Select Release Site Roles dialog) for a paired-

release study. 

 

Figure 5.2: Example of a Status Report for a paired-release study. 
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5.2 Tag Corrections 

Figure 5.3 shows the Tag Correction Report for a paired-release study. All 

tag corrections are the unconditional probability of a tag surviving from activation to 

the given detection site. 

 

Figure 5.3: Example of a Tag Correction Report for a paired-release study. 

5.3 View Mixing 

In a paired-release study, the paired survival estimate is the ratio of the survival 

estimates for the two release groups. Therefore, it is important to design the study so 

that they encounter the same conditions downstream and arrive at downstream 

detection sites at as close to the same times as possible. The timing of the R2 release 

group should be scheduled to achieve this goal. The View Mixing action on the 

navigation panel brings up the Mixing dialog as shown in Figure 5.4 to investigate how 
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well that goal was met. The graph shows the distribution of travel times for both release 

groups. In the box in the lower left corner, the user enters the delay (in hours) between 

the release of the R1 group and the release of the R2 group. In Figure 5.4, there is a 

delay of 12 hours between the release of R1 and R2. The Mixing dialog can also be 

used to plan future studies by trying alternative delay (offset) values to align the 

distributions and determine the best delay time to use in releasing the downstream 

release group. Note that after adjusting the release time offset using the up and down 

arrows in the Mixing dialog, the user must click outside the arrows in order for the 

release time offset to be implemented. 

 

Figure 5.4: Mixing dialog for a paired-release study. 

5.4 Closed Form Parameter Report 

Figure 5.5 shows the Closed Form Parameter Report for a paired-release 
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study with all parameters freely estimated (i.e., no common or constrained 

parameters in the likelihood). In addition to reporting the corrected survival 

estimates, it also displays the paired survival estimate at the top, along with its 

standard error. Note that the results in this report are not adjusted for tag 

corrections. 

  

Figure 5.5: Example of a Closed Form Parameter Report for a paired-release 

study. 
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Chapter 6 — Virtual/Paired-release Study 
Design 

This chapter presents details unique to analyzing data from the virtual/paired-

release study design. Analysis elements that are common to all study designs are 

described in Chapter 3. 

A virtual/paired-release study design is used to estimate the survival of smolts 

through a dam (𝑆𝑆𝐷𝐷𝐷𝐷𝐷𝐷). Details are given in Appendix B.2.3. 

6.1 Define Release Groups 

The capture history data for a virtual/paired-release study consists of three release 

groups. The first is a virtual release, denoted “V1,” composed of all individuals of the 

given release detected at the detection site (virtual release site, or virtual site) at the 

face of the dam. The other two release groups are “R2” and “R3,” which together form 

the downstream paired release as shown in Figure B.2. By default, the first release in 

the capture history data file is used to create the virtual release V1 and the second and 

third releases are assigned to release groups R2 and R3, respectively. Figure 6.1 

shows Define Release Groups for a virtual/paired-release study, allowing the user to 

change the default assignment of releases to release groups. Figure 6.2 shows the 

status report for a virtual/paired-release study. A minimum of three detections sites 

downstream of the virtual site are required for a virtual/paired-release study design. 
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Figure 6.1: Define Release Groups (Select Release Site Roles dialog) for a 

virtual/paired-release study. 

 

Figure 6.2: Example of a Status Report for a virtual/paired-release study. 
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6.2 Tag Corrections 

Figure 6.3 shows a Tag Correction Report for a virtual/paired-release study. 

The tag correction for the column labeled “A0” is the unconditional probability of a 

tag being active at site A0 (the virtual site). For the virtual release V1, the tag 

corrections for the remaining columns, beginning with A1, are the probabilities of a 

tag being active at the site, conditioned on it being alive at site A0. For the R2 and 

R3 releases, the tag-life probabilities are unconditional. 

 

Figure 6.3: Example of a Tag Correction Report for a virtual/paired-release 

study. 

6.3 View Mixing 

With a virtual/paired-release study, as with a paired-release study, it is 

important that the timing of the releases be such that the fish from all release 

groups arrive at the downstream sites at about the same time. The Mixing dialog 
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shown in Figure 6.4 allows the user to view how well that requirement has been 

met and also what release timings should be used for future studies. For the 

virtual/paired-release study design, the user must specify the delay (offset) for 

both of the downstream releases R2 and R3 compared to the time when the fish 

in the V1 group were released at the actual release location upstream of the 

virtual site. 

 

Figure 6.4: Mixing dialog for a virtual/paired-release study. 

6.4 Closed Form Parameter Report 

Figure 6.5 shows the Closed Form Parameter Report for a virtual/paired-

release study. At the top of the report, the dam survival probability (Equation B.33) 

is reported, along with its standard error. 
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Figure 6.5: Example of a Closed Form Parameter Report for a virtual/paired- 

release study. The survival estimates highlighted in red are used to calculate 

the dam survival. 

6.5 Parameter Report 

Figure 6.6 shows the top portion of a Parameter Report for a virtual/paired-

release study after running Compute. As with the Closed Form Parameter Report, the 

dam survival (Equation B.33) is reported at the top of the report. The Parameter Report 
shown in Figure 6.6 reports standard error estimates that include only the variability 

from the release-recapture model (i.e., the Hessian). Once the final configuration has 

been determined, the user must perform Computer Full Variance as explained in 

Section 3.4.3 to perform the bootstrapping to obtain the full standard errors for the 

survival estimates. 
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Figure 6.6: Example of a Parameter Report for a virtual/paired-release study. 

The survival estimates highlighted in red are used to calculate the dam survival. 
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Chapter 7 — Full Virtual Release with 
Dead-fish Correction Study Design 

This chapter presents details unique to analyzing data from the virtual 

release/dead-fish correction study design. Analysis elements that are common to all 

study designs are described in Chapter 3. 

A  study uses a virtual release of live smolts in conjunction with a release of 

dead smolts in the dam tailrace to estimate the survival of smolts through the dam. 

Detections from the dead release are used to adjust dam survival estimates for the 

possibility of detection of dead fish at receiver arrays downstream of the dam. 

Details are given in Appendix B.2.4, and the methodology is given in Harnish et al. 

(2020). An alternative reduced version of the ViRDCt model is described in Chapter 

8.  

7.1 Define Release Groups 

The data for the full ViRDCt study design consist of one virtual release group 

created at the dam face array and one release group of dead smolts in the dam 

tailrace. The virtual release is denoted 𝑉𝑉1, and the dead release D1. By default, the 

first release in the capture history data file is designated as V1, and the second as 

D1. Any subsequent releases will not be used. Thus, if there are multiple upstream 

releases that make up V1, they must be configured with Define Release Groups 

on the Navigation Panel, as shown in Figure 7.1.  
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Figure 7.1: Define Release Groups (Select Release Site Roles dialog) for a full 

ViRDCt study. 

The full ViRDCt model requires exactly three detection sites: the site that 

determines the virtual release (virtual site) and two downstream detection sites 

consisting of a tailrace detection site and a tailwater detection site (Figure B.3). Figure 

7.2 shows the Status Report for a full ViRDCt study. 

 

Figure 7.2: Example of a Status Report for a full ViRDCt study. 
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7.2 View ViRDCt Mixing 

For the ViRDCt study design, the mixing plot shows the virtual release dates of the 

live-released fish (V1 group) in comparison to the release dates of the dead-released 

fish (D1 group). The release dates can either be displayed on the raw scale or on the 

cumulative scale. The default settings for the ViRDCt Mixing dialog restrict the live-

released fish to those that were not detected downstream of the virtual release site, i.e., 

those that were presumed to have died during dam passage. These are the fish that the 

dead-released group is intended to represent. Alternatively, the plot can be generated 

using the entire V1 group, including those that were detected downstream of the dam.  

Figure 7.3 shows the ViRDCt Mixing plot for the full ViRDCt study using the 

default settings. Only four of the V1 tags were not detected downstream of the dam (i.e., 

presumed dead), and they all had virtual release dates in the first half of the release 

period of the D1 group. Thus, it might be worthwhile exploring the sensitivity of the 

model results to use of the entire D1 group compared to only the first half of that group. 

 

Figure 7.3: ViRDCt Mixing dialog for a full ViRDCt study using the default settings. 
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Figure 7.4 shows the ViRDCt Mixing plot for the same data set but now using the full 

set of live-released fish (V1) and on the cumulative scale. The dead-released fish were 

released slightly earlier than the arrival of the live-released fish at the dam, but the 

difference is small and is consistent throughout the study.  

 

Figure 7.4: ViRDCt Mixing dialog for a full ViRDCt study using all tags from the live 

release group and showing the cumulative release distributions. 

7.3 Tag Corrections 

Figure 7.5 shows a Tag Correction Report for a full ViRDCt study. Note the value 

circled in red for the D1 release at site “A2” (the tailwater array). It is sometimes the 

case for a ViRDCt study that there are too few detections of the dead release at the 

tailwater array to estimate the tag-life correction variance. These cases are indicated by 

the message below the table corresponding to the dagger (†), which states that “NAs 

indicate insufficient data to estimate tag life correction variance.” 
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Figure 7.5: Example of a Tag Correction Report for a full ViRDCt study where not all 

tag correction variances are estimable. 

7.4 Parameter Report 

Figure 7.6 shows the Modeled Parameter Report with estimates of dam survival, 

release-specific survival, and detection probabilities. The implication of not being able to 

estimate all tag-life correction variances is that upon computing the parameter 

estimates, the Modeled Parameter Report will reflect variances based only on the 

inverse Hessian. This is equivalent to assuming that the (unestimable) tag correction 

variances are 0.0, and results in an underestimate of the true variance for the survival 

and detection probability estimates. Also, the Compute Full Variance function will be 
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unavailable. A warning message is included in the Modeled Parameter Report in this 

case (Figure 7.6).  

 

Figure 7.6: Modeled Parameter Report for a full ViRDCt study where not all tag 

correction variances are estimable. Survival estimates in red are used in the calculation 

of dam survival. 

The Closed Form Parameter Report is unavailable for a full ViRDCt study, 

regardless of whether all tag correction variances are estimable. 

7.5 Equate Parameters Across Releases 

For the full ViRDCt study design, the only parameters that may be equated across 

the V1 and D1 releases are the detection probabilities in the tailrace, as shown in Figure 

7.7. 
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Figure 7.7: Equate Parameter Across Releases dialog for a full ViRDCt study. 

7.6 Constrain Parameters 

The survival parameters for the full ViRDCt study design may be constrained by 

the logit function (Figure 7.8), and the capture parameters (including the combined 

survival and capture probability in the last reach) may be fixed to 1.0 (Figure 7.9). 

 

Figure 7.8: Constrain Parameters dialog on the Survival tab for a full ViRDCt study. 
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Figure 7.9: Constrain Parameters dialog on the Capture tab for a full ViRDCt study.
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Chapter 8 – Reduced Virtual Release 
with Dead-fish Correction Study Design 

Like the full ViRDCt model described in Chapter 7, the reduced ViRDCt model is 

used to analyze data from the virtual release/dead-fish correction study design. The 

difference is that the reduced ViRDCt model does not use tailwater detections from the 

dead fish release; it only uses dead-release detections in the tailrace. 

The reduced ViRDCt model can be used instead of the full ViRDCt model when 

there are no dead fish detections in the tailwater, or if the dead-release detections are 

too sparse for estimation with the full ViRDCt model; if there are detections in the 

tailwater, they will be ignored by the reduced ViRDCt model. Switching from the full 

ViRDCt study design to the reduced ViRDCt study design requires the user to reload 

the data. 

8.1 Define Release Groups 

The release groups are defined in the same way as described in Section 7.1 for 

the full model. The reduced ViRDCt model requires exactly three detection sites for the 

live releases, and one detection site for the dead-fish release (tailrace site); if there are 

two detection sites for the dead-fish release, detections at the second site will be 

ignored. 

8.2 Tag Corrections 

Figure 8.1 shows a Tag Correction Report for a reduced ViRDCt study. In 

contrast to the full ViRDCt example in Figure 7.5, there is only one downstream 

detection site for the dead-fish release. 
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Figure 8.1: Tag Correction Report for a reduced ViRDCt study. 

8.3 Closed Form Parameter Report 

Unlike the full ViRDCt model, closed form estimates exist for the reduced ViRDCt 

model. Figure 8.2 shows an example of a Closed Form Parameter Report. This report 

is available only if there is only one bin and only one upstream release in the virtual 

release. 
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Figure 8.2: Closed Form Parameter Report for a reduced ViRDCt study. 

8.4 Parameter Report 

Figure 8.3 shows the Modeled Parameter Report for the reduced ViRDCt 

model. In this example, the detection probability has been fixed to 1.0 at the tailrace in 

order for the parameters to be estimable (see Section 8.6).  
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Figure 8.3: Modeled Parameter Report for a reduced ViRDCt study. Survival 

estimates in red are used in the calculation of the dam survival. 
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8.5 Parameter Report Equate Parameters Across 
Releases 

For the reduced ViRDCt study design, no parameters can be equated. 

8.6 Constrain Parameters 

The one survival parameter for the reduced ViRDCt study design that may be 

constrained by the logit function is the dam survival (Figure 8.4).  

 

Figure 8.4: Constrain Parameters dialog on the Survival tab for a reduced ViRDCt 

study. 

The capture parameters (including the combined survival and capture probabilities 

in the last reach for each release group) may be fixed to 1.0 as shown in Figure 8.5. 
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Figure 8.5: Constrain Parameters dialog on the Capture tab for a reduced ViRDCt 

study. 
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Appendix A — Input Data Files 

A.1 Capture History Data File 

The capture history data file is a comma separated value (.csv) text file. This 

data file can be created by using the TagPro utility available on the Columbia Basin 

Research website. A portion of an example of a capture history data file is shown in 

Figure A.1. The columns are as follows, in the required order: 

1. name of the release 

2. bin number 

3. tag ID 

4. tag activation date and time 

5. tag release date and time 

6. site name 

7. “1” if the tag was detected at the site, “2” if tag is to be censored at that site, 

or “0” otherwise 

8. the detection date and time if detected, blank otherwise 

Tag activation and release date and times must be in the form “yyyy-mm-dd 

hh:mm:ss.” The file must be sorted by, in order of precedence, the release name, bin 

number, tag ID, and finally by site name (from upstream to downstream). Because fish 

are assumed to be moving in only one direction, only one detection per site per tag is 

allowed, and only downstream movement is allowed. Detection times should be the first 

detection at the sites for each tag in order to minimize the amount of correction 

estimated for tag failure. The first line of the capture history data file may be column 

labels if desired; if present, it will be ignored by Program ATLAS. 

Because the capture history data file is in CSV format, it can be easily read 

and edited via a spreadsheet program (Warning: MS Excel saves date-time fields 

https://www.cbr.washington.edu/analysis/apps/tagproapp
https://www.cbr.washington.edu/analysis/apps/tagproapp
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in the wrong format by default). This allows a user to create, for example, 

multiple bins per release based on the delay between release time and activation 

time (see Section 3.3.2 for an explanation of bins). 

 

Figure A.1: Portion of a capture history data file. 

A.2 Attribute Group File 

The attribute group file defines one or more attributes and assigns tag codes 

to attribute values. It is a .csv text file. An example, loaded into a spreadsheet 

program, is shown in Figure A.2. The first column is always the tag codes. The first 

row names the tag code column (it can be anything) and also labels each attribute. 

In Figure A.2, two attributes are defined: “tagger” and “tag lot.” If a combination of 

columns is desired (e.g., tagger × tag lot), a separate column must be added, 

appropriately coded. 
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Figure A.2: Top portion of an attribute group file. 

A.3 Tag-life Data File 

The tag-life data file contains the results of the independent tag-life test 

conducted to estimate tag-life corrections. It is a text file with each row containing 

the observed failure time, in days, for each tag. There must be one line for each 

tag. For example, if three tags failed at 25.5 days, then the number 25.5 must occur 

three times in the file. The first line may be an optional label which will be ignored 

by Program ATLAS. A portion of an example of a tag-life data file is shown in Figure 

A.3. 

 

Figure A.3: Portion of the tag-life data file. 
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Appendix B — Statistical Methods used 
in ATLAS 

B.1 Tag-life Analyses 

Tag-life analysis is performed using tag-life data, in which a group of tags in a 

test group are monitored for failure. At each failure, the time and number of 

remaining tags are recorded. The objective of tag-life analysis is to estimate a 

statistical model of the time of failure, or “tag life,” of tags represented by the test 

group. 

B.1.1 Parametric Failure-time Distributions 

One of the simplest models for failure-time data is the exponential distribution. 

The exponential probability density function (PDF) can be written as 

𝑓𝑓(𝑡𝑡) = �
1
λ
𝑒𝑒− 1λ𝑡𝑡 𝑡𝑡 ≥ 0

0     𝑡𝑡 < 0
, (B. 1) 

with survivorship function 

𝑆𝑆(𝑡𝑡) = 𝑒𝑒− 1λ𝑡𝑡 , (B. 2) 

cumulative distribution function (CDF) 

𝐹𝐹(𝑡𝑡) = 1 − 𝑒𝑒− 1λ𝑡𝑡 , (B. 3) 

and hazard function (Lee, 1992, p. 132) 

ℎ(𝑡𝑡) =
1
λ

, 𝑡𝑡 ≥ 0. (B. 4) 

The exponentially declining survivorship function for the exponential 
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distribution (Equation B.2) is too severe for typical tag-failure times and not 

commonly used to model tag life. However, it is the basis for more commonly used 

parametric distributions such as the two-parameter and three-parameter Weibull, so 

it is included here.  

B.1.1.1 Two-parameter Weibull 

An extension of the exponential distribution, the two-parameter Weibull 

distribution (Lawless 1982, pp. 15–17; Lee 1992, pp. 136–137) has both a scale 

parameter (λ) and a shape parameter (β). The PDF for the two-parameter Weibull is 

𝑓𝑓(𝑡𝑡) =
β
λ �
𝑡𝑡
λ�

β−1
𝑒𝑒−�

𝑡𝑡
λ�

β

, (B. 5) 

with survivorship function 

𝑆𝑆(𝑡𝑡) = 𝑒𝑒−�
𝑡𝑡
λ�

β

, (B. 6) 

CDF 

𝐹𝐹(𝑡𝑡) = 1 − 𝑒𝑒−�
𝑡𝑡
λ�

β

, (B. 7) 

and hazard function 

ℎ(𝑡𝑡) =
β
λ �
𝑡𝑡
λ�

β−1
. (B. 8) 

When β = 1, the two-parameter Weibull (Equation B.5) reduces to the exponential 

distribution (Equation B.1). 

B.1.1.2 Three-parameter Weibull 

An extension of the two-parameter Weibull distribution is the three-parameter 

Weibull distribution (Elandt-Johnson and Johnson, 1980, p. 62) with scale (λ), 

shape (β), and shift (γ) parameters. The PDF of the three-parameter Weibull 

distribution is 
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𝑓𝑓(𝑡𝑡) =
β
λ �
𝑡𝑡 − γ
λ �

β−1
𝑒𝑒−�

𝑡𝑡−γ
λ �

β

, (B. 9) 

with survivorship function 

𝑆𝑆(𝑡𝑡) = 𝑒𝑒−�
𝑡𝑡−γ
λ �

β

, (B. 10) 

CDF 

𝐹𝐹(𝑡𝑡) = 1 − 𝑒𝑒−�
𝑡𝑡−γ
λ �

β

, (B. 11) 

and hazard function 

ℎ(𝑡𝑡) =
β
λ �
𝑡𝑡 − 𝛾𝛾
λ �

β−1
. (B. 12) 

The three-parameter Weibull reduces to the two-parameter Weibull when γ = 0; it 

reduces to the exponential distribution when β = 1 and γ = 0. Likelihood ratio 

tests can be used to help select between the two- and three-parameter Weibull 

distributions (i.e., 𝐻𝐻0: γ = 0 vs. 𝐻𝐻𝑎𝑎 : γ ≠ 0), as can the Akaike Information Criterion. 

B.1.1.3 Vitality Model 

The vitality model of Li and Anderson (2009) has been found useful in 

modeling tag failure-time data in cases where the shoulder of the curve has more 

slope than expected by the Weibull distribution. The steeper slope to the shoulder is 

the result of one or several tags failing much sooner than the rest. The vitality model 

is not nested within the Weibull family of distributions and, as such, cannot be 

directly compared. 

The survival function for the vitality model can be written as 

𝑆𝑆(𝑡𝑡) = �ϕ �
1− 𝑟𝑟𝑟𝑟

√𝑢𝑢2 + 𝑠𝑠2𝑡𝑡
� − 𝑒𝑒�

2𝑢𝑢2𝑟𝑟2
𝑠𝑠4 +2𝑟𝑟𝑠𝑠2� ∙ ϕ�−

1 + 𝑟𝑟𝑟𝑟 + 2𝑢𝑢2𝑟𝑟
𝑠𝑠2

√𝑢𝑢2 + 𝑠𝑠2𝑡𝑡
�� 𝑒𝑒−𝑘𝑘𝑘𝑘 (B. 13) 

where 
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ϕ = cumulative normal distribution, 

𝑟𝑟 = average wear rate of components, 

𝑠𝑠 = standard deviation in wear rate, 

𝑘𝑘 = rate of accidental failure, and 

𝑢𝑢 = standard deviation in quality of original components. 

The random failure component, in addition to the rate of wear, gives the vitality 

model additional latitude to fit tag-life data. 

B.1.2 Nonparametric Method 

The Kaplan and Meier (1958) method, also known as the product-limit 

estimator, is a nonparametric approach to estimating a survivorship curve. This 

method is a discrete-time approach to survival curve estimation. At time zero (𝑡𝑡0), 

survivorship 𝑆𝑆(𝑡𝑡0) = 1. Each declining step in the survivorship curve corresponds to 

the time of failure for a tag. The survival process continues until the last tag fails 

at time 𝑡𝑡𝐿𝐿, where 𝑆𝑆(𝑡𝑡𝐿𝐿) = 0. In any time interval from t to t + 1, the conditional 

survival probability is estimated by 

𝑃𝑃�(𝑋𝑋 > 𝑡𝑡 + 1|𝑡𝑡) = 𝑆̂𝑆𝑡𝑡 =
𝑙𝑙𝑡𝑡 −  𝑑𝑑𝑡𝑡
𝑙𝑙𝑡𝑡

, (𝐵𝐵. 14) 

where 

𝑙𝑙𝑡𝑡 = number of tags still active and at risk of failure in the time interval t to t + 1, 

𝑑𝑑𝑡𝑡 = number of tags that failed during the time interval t to t + 1, and 

𝑋𝑋 = random variable for time of failure. 

The binomial estimator (Equation B.14) has the estimated variance 

Var� �𝑆̂𝑆𝑡𝑡� =
𝑆̂𝑆𝑡𝑡�1 − 𝑆̂𝑆𝑡𝑡�

𝑙𝑙𝑡𝑡
. (B. 15) 
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The product-limit estimator acquires its name because the estimator of survival from 

time 0 to t is simply the product 

S�(𝑡𝑡) = 𝑆̂𝑆0 ∙ 𝑆̂𝑆1 ∙ 𝑆̂𝑆2 ∙∙∙ 𝑆̂𝑆𝑡𝑡 

        = ��
𝑙𝑙𝑖𝑖 − 𝑑𝑑𝑖𝑖
𝑙𝑙𝑖𝑖

�
𝑡𝑡−1

𝑖𝑖=0

. (B. 16) 

These nonparametric estimators are applicable whether or not right-censoring 

has occurred. The Kaplan and Meier (1958) method may be used when no 

parametric model adequately fits the tag-life data. 

B.1.3 Right-censored Tag-life Analyses 

There are at least two scenarios where a right-censored tag-life analysis may 

be useful and appropriate. The first scenario occurs when the tag-life study is 

stopped or truncated before the last tag failure. The second scenario can occur 

when observed travel times are relatively short compared to observed tag-failure 

times, and it is more accurate and easier to model tag-failure times to some 

truncation point beyond the longest travel time. The latter truncation strategy may 

be useful when traditional failure-time distributions have difficulty fitting both the 

shoulder and tail end of the failure-time curve. When inferences near the tail end of 

the failure-time distributions are unnecessary, a truncated analysis may do a better 

job at fitting the shoulder of the survivorship curve where travel times are relevant. 

For the right-censored analysis, let 𝑇𝑇 be the time of truncation. The other 

terms are defined as follows: 

𝑓𝑓(𝑡𝑡𝑖𝑖)  = PDF for failure times (𝑡𝑡𝑖𝑖; 𝑡𝑡 = 1, …, 𝑛𝑛), 

𝐹𝐹(𝑡𝑡𝑖𝑖)  = cumulative survival function to time 𝑡𝑡𝑖𝑖, 

= ∫ 𝑓𝑓(𝑡𝑡)𝑑𝑑𝑑𝑑𝑡𝑡𝑖𝑖
0 , 

𝑆𝑆(𝑡𝑡𝑖𝑖) = 1 − 𝐹𝐹(𝑡𝑡𝑖𝑖), survival function, 
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𝑛𝑛 = number of tags used in the tag-life study, and 

𝑟𝑟 = number of tags that failed on or before truncation time 𝑇𝑇 out of 𝑛𝑛 tags starting 

the study. 

The likelihood model for a truncated analysis is as follows: 

𝐿𝐿 = ��
𝑓𝑓(𝑡𝑡𝑖𝑖)
𝐹𝐹(𝑇𝑇)� �

𝑛𝑛
𝑟𝑟�

𝑟𝑟

𝑖𝑖=1

�1 − 𝑆𝑆(𝑇𝑇)�𝑟𝑟𝑆𝑆(𝑇𝑇)𝑛𝑛−𝑟𝑟 . (B. 17) 

Noting 1 − 𝑆𝑆(𝑇𝑇) = 𝐹𝐹(𝑇𝑇), 

𝐿𝐿 = ��
𝑓𝑓(𝑡𝑡𝑖𝑖)
𝐹𝐹(𝑇𝑇)� �

𝑛𝑛
𝑟𝑟�

𝑟𝑟

𝑖𝑖=1

𝐹𝐹(𝑇𝑇)𝑟𝑟𝑆𝑆(𝑇𝑇)𝑛𝑛−𝑟𝑟  

∝�𝑓𝑓(𝑡𝑡𝑖𝑖) ∙ 𝑆𝑆(𝑇𝑇)𝑛𝑛−𝑟𝑟
𝑟𝑟

𝑖𝑖=1

. (B. 18) 

This follows the development in Lee (1992, p. 203). 

B.2 Tag-life Adjusted Estimates of Survival 

With active tags, standard CJS models estimate a “perceived” survival 

probability, i.e., the joint probability of the fish surviving and the tag operating at a 

downstream detection site. Using the method in Townsend et al. (2006), tag-life-

adjusted estimates of survival are calculated, taking into account independent 

information from a tag-life study. 

Program ATLAS provides the ability to calculate tag-life-adjusted survival 

estimates for a (1) single release-recapture design, (2) paired release-recapture 

design, (3) virtual/paired release-recapture design, and (4) full ViRDCt release-

recapture design. The latter three designs are based on the fundamental 

multinomial model of the single release-recapture design which will be presented 

first. 
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B.2.1 Single Release-recapture Design 

The single release-recapture design will be conceptualized as an initial release 

of tagged animals followed by K subsequent downstream detection events. The 

initial release event is defined as event 0. The subsequent detection events are 

numbered 1 through K. The model parameters are defined as follows: 

𝑆𝑆𝑖𝑖 = probability of surviving to event 𝑖𝑖, given survival to event 𝑖𝑖 − 1 (𝑖𝑖 = 1,…, 𝐾𝐾 −

1), 

𝑝𝑝𝑖𝑖 = probability of detection at event 𝑖𝑖, given survival to event 𝑖𝑖 (𝑖𝑖 = 1,…, 𝐾𝐾 − 1), 

𝜆𝜆 = probability of survival to and detection at event 𝐾𝐾, given survival to event 𝐾𝐾 −

1, 

𝑇𝑇𝑖𝑖 = probability that a tag will be active at event 𝑖𝑖, and 

𝑇𝑇𝑖𝑖 𝑗𝑗⁄ = probability that a tag will be active at event 𝑖𝑖, given that it was active at 

event 𝑗𝑗 < 𝑖𝑖 

= 𝑇𝑇𝑖𝑖
𝑇𝑇𝑗𝑗

, where 𝑖𝑖 = 𝑗𝑗 + 1,…, 𝐾𝐾. 

Other quantities in the model include the following: 

𝑅𝑅0 = initial release size. 

𝑅𝑅𝑖𝑖 = number detected and re-released (i.e., not removed from the release group) 

at event 𝑖𝑖. 

𝑧𝑧𝑖𝑖 = number detected and re-released before event 𝑖𝑖, not detected at event 𝑖𝑖, but 

detected after event 𝑖𝑖, 

= ��𝑟𝑟𝑗𝑗 − 𝑚𝑚𝑗𝑗+1�.
𝑖𝑖−1

𝑗𝑗=0

 

𝑚𝑚𝑖𝑖 = number detected at event 𝑖𝑖 (𝑖𝑖 = 1,…, 𝐾𝐾 − 1). 
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𝑟𝑟𝑖𝑖 = number detected (and re-released) at event 𝑖𝑖 and detected at a later event 

(𝑖𝑖 = 0, …, 𝐾𝐾 − 1). 

For convenience in re-expressing the likelihood model, the following terms are also 

defined: 

χ𝑖𝑖 = probability of an individual not being detected after event 𝑖𝑖, conditional on 

surviving with a working tag to event 𝑖𝑖 (𝑖𝑖 = 0, … , 𝐾𝐾 − 1), 

where 

χ𝑖𝑖 = 1 −  𝑇𝑇𝑖𝑖+1 𝑖𝑖⁄ + 𝑇𝑇𝑖𝑖+1 𝑖𝑖⁄ (1 − 𝑆𝑆𝑖𝑖+1 + 𝑆𝑆𝑖𝑖+1(1 − 𝑝𝑝𝑖𝑖+1)χ𝑖𝑖+1) 

= 1 −  𝑇𝑇𝑖𝑖+1 𝑖𝑖⁄ 𝑆𝑆𝑖𝑖+1 + 𝑇𝑇𝑖𝑖+1 𝑖𝑖⁄ χ𝑖𝑖+1𝑆𝑆𝑖𝑖+1(1 − 𝑝𝑝𝑖𝑖+1), 

and 

χ𝐾𝐾−1 = 1 − 𝑇𝑇𝐾𝐾 𝐾𝐾−1⁄ + 𝑇𝑇𝐾𝐾 𝐾𝐾−1⁄ (1 − λ) = 1 − 𝑇𝑇𝐾𝐾 𝐾𝐾−1⁄ λ. 

Also, 

τ𝑖𝑖 = 𝑇𝑇𝑖𝑖χ𝑖𝑖 

= 𝑇𝑇𝑖𝑖 − 𝑇𝑇𝑖𝑖+1𝑆𝑆𝑖𝑖+1 + τ𝑖𝑖+1𝑆𝑆𝑖𝑖+1(1 − 𝑝𝑝𝑖𝑖+1), (𝑖𝑖 = 1, … , 𝐾𝐾 − 2), 

where 

τ0 = χ0 

and where 

τ𝐾𝐾−1 = 𝑇𝑇𝐾𝐾−1χ𝐾𝐾−1 = 𝑇𝑇𝐾𝐾−1 − 𝜏𝜏𝐾𝐾λ. 

The general form of the likelihood can then be written as 

𝐿𝐿�𝑆𝑆, 𝑝⃗𝑝, 𝜆𝜆�𝑅𝑅�⃗ ,𝑚𝑚��⃗ , 𝑟𝑟, 𝑧𝑧,𝑇𝑇�⃗ � = ��𝑆𝑆𝑘𝑘
𝑚𝑚𝑘𝑘+𝑧𝑧𝑘𝑘𝑝𝑝𝑘𝑘

𝑚𝑚𝑘𝑘(1 − 𝑝𝑝𝑘𝑘)𝑧𝑧𝑘𝑘
𝐾𝐾−1

𝑘𝑘=1

� (𝑇𝑇𝐾𝐾𝜆𝜆)𝑟𝑟𝐾𝐾−1+𝑧𝑧𝐾𝐾−1�𝜏𝜏𝑘𝑘
𝑅𝑅𝑘𝑘−𝑟𝑟𝑘𝑘

𝐾𝐾−1

𝑘𝑘=0

. (B. 19) 
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Example: Likelihood with three downstream detection locations 

With three downstream detection locations, there are 2^3=8 possible 

capture/detection histories. Those histories in standard order, along with the 

corresponding cell probabilities of occurrence, are as follows: 

Capture/detection history Probability of occurrence 
1 1 1 -𝑇𝑇3𝑆𝑆1𝑝𝑝1𝑆𝑆2𝑝𝑝2λ 

0 1 1 𝑇𝑇3𝑆𝑆1(1 − 𝑝𝑝1) 𝑆𝑆2𝑝𝑝2λ 

1 0 1 𝑇𝑇3𝑆𝑆1𝑝𝑝1𝑆𝑆2(1 − 𝑝𝑝2) λ 

0 0 1 𝑇𝑇3𝑆𝑆1(1 − 𝑝𝑝1) 𝑆𝑆2(1 − 𝑝𝑝2) λ 

1 1 0 𝑆𝑆1𝑝𝑝1𝑆𝑆2𝑝𝑝2𝑇𝑇2χ2 = 𝑆𝑆1𝑝𝑝1𝑆𝑆2𝑝𝑝2𝜏𝜏2 

0 1 0 𝑆𝑆1(1 − 𝑝𝑝1) 𝑆𝑆2𝑝𝑝2τ2 

1 0 0 𝑆𝑆1𝑝𝑝1τ1 

0 0 0 χ0 

The likelihood model in Equation B.19 temporarily treats the probabilities of tag 

life (𝑇𝑇𝑖𝑖) as known constants. For a particular study outcome, the 𝑇𝑇𝑖𝑖 are empirically 

estimated based on the observed capture data and individual travel times to 

event 𝑖𝑖 (𝑖𝑖 =  1, …, 𝐾𝐾). For all individuals detected at event 𝑖𝑖, the estimated 

probability of tag life is calculated as 

𝑇𝑇�𝑖𝑖 =
∑ 𝑃𝑃�𝑥𝑥𝑗𝑗 ≥ 𝑑𝑑𝑖𝑖𝑖𝑖�
𝑚𝑚𝑖𝑖
𝑗𝑗=1

𝑚𝑚𝑖𝑖
 

=
∑ 𝑆𝑆�𝑑𝑑𝑖𝑖𝑖𝑖�
𝑚𝑚𝑖𝑖
𝑗𝑗=1

𝑚𝑚𝑖𝑖
 

where 

𝑆𝑆(𝑑𝑑𝑖𝑖𝑖𝑖)  = probability a tag is active at least as long as time 𝑑𝑑𝑖𝑖𝑖𝑖, where 𝑆𝑆( ) is 

based on the fitted tag-life survivorship function, and 

𝑑𝑑𝑖𝑖𝑖𝑖 = time between tag activation and detection at event 𝑖𝑖 for the 𝑗𝑗th individual 
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detection at event 𝑖𝑖 (𝑖𝑖 = 1, …, 𝐾𝐾; 𝑗𝑗 = 1, …, 𝑚𝑚𝑖𝑖). 

The inverse Hessian matrix provides an estimate of the variance-covariance 

matrix for the maximum likelihood estimators, given the particular set of tag-life 

probabilities (i.e., 𝑇𝑇�𝑖𝑖; 𝑖𝑖 = 1,…, 𝐾𝐾) used in the model. However, those variance 

estimates do not take into account the uncertainties in the estimates 𝑇𝑇�𝑖𝑖  (𝑖𝑖 =

1,…,𝐾𝐾). The variance of the survival estimates can be calculated using the total 

variance formula 

Var�𝑆̂𝑆� = Var𝑇𝑇�⃗ 𝑖𝑖 �𝐸𝐸 �𝑆̂𝑆�𝑇𝑇�
��⃗
𝑖𝑖�� + 𝐸𝐸𝑇𝑇���⃗ 𝑖𝑖 �𝑉𝑉𝑉𝑉𝑉𝑉 �𝑆̂𝑆�𝑇𝑇

���⃗ 𝑖𝑖�� . (B. 20) 

The above variance can be estimated in stages using the expression 

Var� �𝑆̂𝑆� = 𝑠𝑠
𝑆̂𝑆|𝑇𝑇���⃗ 𝑖𝑖
2 + Var� �𝑆̂𝑆�𝑇𝑇���⃗ 𝑖𝑖� . (B. 21) 

The second term in Equation B.21 is obtained from the inverse Hessian matrix 

conditional on the observed tag-life probabilities (𝑇𝑇���⃗ 𝑖𝑖). The first variance component 

in Equation B.21 can be calculated using bootstrap resampling techniques (Efron 

and Tibshirani 1993). Alternative estimates of 𝑇𝑇���⃗ 𝑖𝑖 are computed by bootstrapping 

both the observed tag-life data and the travel-time data. For each estimated vector 

𝑇𝑇���⃗ 𝑖𝑖, survival estimates are recalculated using the likelihood model in Equation B.19. 

The empirical variance among those alternative survival estimates is used in 

estimating the first term in Equation B.21 by the quantity 

𝑠𝑠
𝑆̂𝑆|𝑇𝑇���⃗ 𝑖𝑖
2 =

∑ �𝑆̂𝑆𝑏𝑏 − 𝑆̂̅𝑆�
2

𝐵𝐵
𝑏𝑏=1

𝐵𝐵 − 1
, (B. 22) 

where 

𝑆̂̅𝑆 =
∑ 𝑆̂𝑆𝑏𝑏𝐵𝐵
𝑏𝑏=1

𝐵𝐵
. 

We recommend B be of the order 1000 or greater. 

An alternative to directly estimating the survival parameters from the likelihood 
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model is to analyze the detection histories using an ordinary CJS model. This 

approach will result in a “perceived” survival value �𝜙𝜙�𝑖𝑖�, which is the joint 

probability of both the fish and tag being “alive” at a detection site. The reach 

survival estimate for the fish alone ( 𝑆̂𝑆𝑖𝑖) is then obtained from the ratio estimator 

𝑆̂𝑆𝑖𝑖 =
𝜙𝜙�𝑖𝑖

� 𝑇𝑇�𝑖𝑖
𝑇𝑇�𝑖𝑖−1

�
= 𝜙𝜙�𝑖𝑖 �

𝑇𝑇�𝑖𝑖−1
𝑇𝑇�𝑖𝑖

� , (B. 23) 

where 𝑇𝑇�0= 1.0. Using the exact variance estimator for a product (Goodman 1960) 

Var� �𝑆̂𝑆𝑖𝑖� = 𝜙𝜙�𝑖𝑖
2Var� �

𝑇𝑇�𝑖𝑖−1
𝑇𝑇�𝑖𝑖

� + �
𝑇𝑇�𝑖𝑖−1
𝑇𝑇�𝑖𝑖

�
2

Var� �𝜙𝜙�𝑖𝑖� − Var� �
𝑇𝑇�𝑖𝑖−1
𝑇𝑇�𝑖𝑖

�Var� �𝜙𝜙�𝑖𝑖�, (B. 24) 

where, using the delta method (Seber 1982, pp. 7–9), 

Var� �𝑆̂𝑆𝑖𝑖� = 𝜙𝜙�𝑖𝑖
2Var� �

𝑇𝑇�𝑖𝑖−1
𝑇𝑇�𝑖𝑖

� + �
𝑇𝑇�𝑖𝑖−1
𝑇𝑇�𝑖𝑖

�
2

Var� �𝜙𝜙�𝑖𝑖� − Var� �
𝑇𝑇�𝑖𝑖−1
𝑇𝑇�𝑖𝑖

�Var� �𝜙𝜙�𝑖𝑖�, (B. 25) 

The variance of 𝑇𝑇�𝑖𝑖 is estimated by the bootstrap technique using both the 

observed travel times (𝑑𝑑�⃗ 𝑖𝑖𝑖𝑖) and tag-life data. The variance of 𝑇𝑇�𝑖𝑖  is calculated as 

Var� �𝑇𝑇�𝑖𝑖� = (1 − 𝑝̂𝑝𝑖𝑖) �𝑠𝑠𝑇𝑇�𝑖𝑖
2 − 𝑠𝑠𝑇𝑇�𝑖𝑖|𝑑⃗𝑑

2 � + 𝑠𝑠𝑇𝑇�𝑖𝑖|𝑑⃗𝑑
2 , (B. 26) 

where 

𝑠𝑠𝑇𝑇�𝑖𝑖
2 = empirical bootstrap variance for 𝑇𝑇�𝑖𝑖 when sampling with replacement from 

both the tag-life and travel-time data, and 

𝑠𝑠𝑇𝑇�𝑖𝑖|𝑑⃗𝑑
2 = empirical bootstrap variance for 𝑇𝑇�𝑖𝑖 when sampling with replacement from 

the tag-life data holding the travel times constant for what was observed. 

The quantity �𝑠𝑠𝑇𝑇�𝑖𝑖
2 − 𝑠𝑠𝑇𝑇�𝑖𝑖|𝑑⃗𝑑

2 � estimates the variance component associated solely 

with the variation in travel times. The factor (1 − 𝑝̂𝑝𝑖𝑖) serves as a finite population 

correction for this variance component. For example, if 𝑝𝑝𝑖𝑖 = 1, then the distribution 
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of travel times is known without error and should not contribute to the uncertainty 

of 𝑇𝑇�𝑖𝑖.  

When estimating two or more tag-life probabilities, their covariance is assumed 

to be zero if they are from different tag-life datasets; if from the same tag-life 

dataset, their covariance is estimated by the quantity 

Covar� �𝑇𝑇�𝑖𝑖,𝑇𝑇�𝑗𝑗� = (1 − 𝑝̂𝑝𝑖𝑖)�1 − 𝑝̂𝑝𝑗𝑗��cov� �𝑇𝑇�𝑖𝑖 ,𝑇𝑇�𝑗𝑗� − cov� �𝑇𝑇�𝑖𝑖,𝑇𝑇�𝑗𝑗|𝑑𝑑�� + cov� �𝑇𝑇�𝑖𝑖 ,𝑇𝑇�𝑗𝑗|𝑑𝑑�, (B. 27) 

where 

Variable Definition 

cov� �𝑇𝑇�𝑖𝑖,𝑇𝑇�𝑗𝑗� = empirical bootstrap covariance between 𝑇𝑇�𝑖𝑖 

and 𝑇𝑇�𝑗𝑗 bootstrapping over the tag-life and 

travel-time data, and 

cov� �𝑇𝑇�𝑖𝑖 ,𝑇𝑇�𝑗𝑗|𝑑𝑑� = empirical bootstrap covariance between 𝑇𝑇�𝑖𝑖 

and 𝑇𝑇�𝑗𝑗 bootstrapping over only the tag-life 

data, holding the travel times constant for 

what was observed, 

where once again the 𝑝̂𝑝𝑖𝑖 and 𝑝̂𝑝𝑗𝑗 are estimated detection probabilities at sites 𝑖𝑖 and 

𝑗𝑗, respectively. The quantity (1− 𝑝̂𝑝𝑖𝑖)(1 − 𝑝̂𝑝𝑗𝑗) is the finite correction term when 

computing the variance. 

B.2.2 Paired Release-recapture Design 

In Program ATLAS, the paired release-recapture design is modeled as a 

product of two independent likelihoods of the form in Equation B.19. The joint 

likelihood model is parameterized as depicted in Figure B.1. The model estimates 

separate values for each release. Survival between the release points is then 

estimated by the quotient 
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𝑆̂𝑆𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 =
𝑆̂𝑆11
𝑆̂𝑆21

, (B. 28) 

with an associated variance estimate (Goodman, 1960) 

Var� (𝑆̂𝑆𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃) = 𝑆̂𝑆𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃2 �
Var� �𝑆̂𝑆11�
𝑆̂𝑆112

+
Var� �𝑆̂𝑆21�
𝑆̂𝑆212

−
Var� �𝑆̂𝑆11)Var� (𝑆̂𝑆21�

𝑆̂𝑆112 𝑆̂𝑆212
� . (B. 29) 

Below the mixing zone of the two release groups in a paired release, likelihood 

ratio tests can be used to assess homogeneity of downstream capture and survival 

processes. Modeling of the lower reach survival and detection processes may be 

used to improve estimation precision. Should model parameters between the two 

releases be linked (i.e., equated), subsequent estimates of 𝑆̂𝑆11 and 𝑆̂𝑆21 will no 

longer be independent. In this case, the variance of survival (Equation B.28) will be 

estimated using the delta method (Seber 1982, pp. 7–9), where 

Var� (𝑆̂𝑆𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃) ≈ 𝑆̂𝑆𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃2 �
Var� �𝑆̂𝑆11�
𝑆̂𝑆112

+
Var� �𝑆̂𝑆21�
𝑆̂𝑆212

−
2Covar��𝑆̂𝑆11, 𝑆̂𝑆21�

𝑆̂𝑆11𝑆̂𝑆21
� . (B. 30) 

Alternatively, a closed-form estimator of 𝑆𝑆 can be calculated as 

𝑆𝑆�𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 =
�
𝜙𝜙�11
𝑇𝑇�11

�

�
𝜙𝜙�21
𝑇𝑇�21

�
= �

𝜙𝜙�11
𝜙𝜙�21

��
𝑇𝑇�21

𝑇𝑇�11
� , (B. 31) 

where 𝜙𝜙�𝑖𝑖𝑖𝑖  is the “perceived” survival estimate from a traditional CJS model ignoring 

tag-life probabilities, and 𝑇𝑇�𝑖𝑖𝑖𝑖 is the estimated probability of tag life. In this case, the 

variance of 𝑆̂𝑆 is estimated by applying the Goodman (1960) approach, i.e., 

Var� ��
𝜙𝜙�11
𝜙𝜙�21

��
𝑇𝑇�21
𝑇𝑇�11

�� = �
𝜙𝜙�11
𝜙𝜙�21

�
2

Var� �
𝑇𝑇�21
𝑇𝑇�11

� + �
𝑇𝑇�21
𝑇𝑇�11

�
2

Var� �
𝜙𝜙�11
𝜙𝜙�21

� − Var� �
𝜙𝜙�11
𝜙𝜙�21

�Var� �
𝑇𝑇�21
𝑇𝑇�11

� . (B. 32) 

The variance of 𝜙𝜙�11/𝜙𝜙�21 is computed analogously to Equation B.29, and the variance 

of 𝑇𝑇�21/𝑇𝑇�11 analogously to Equation B.25. 
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Figure B.1: Schematic of a paired release-recapture design. 

B.2.3 Virtual/Paired Release-recapture Design 

This release-recapture design is used to estimate the probability of dam 

passage survival consistent with the 2008 FCRPS Biological Opinion definition of 

survival from the dam face to the tailrace (Figure B.2). In the simplest of cases, the 

joint likelihood model consists of three independent multinomial likelihoods of the 
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form of Equation B.19. In this case, dam passage survival is estimated by the 

function 

𝑆̂𝑆𝐷𝐷𝐷𝐷𝐷𝐷 =
𝑆̂𝑆1

�𝑆̂𝑆2
𝑆̂𝑆3
�

=
𝑆̂𝑆1𝑆̂𝑆3
𝑆̂𝑆2

, (B. 33) 

where the 𝑆̂𝑆𝑖𝑖 variables are the tag-life-corrected estimates of reach survival. 

 

Figure B.2: Schematic of the minimum design configuration to estimate dam 

passage survival based on a virtual release (i.e., 𝑽𝑽𝟏𝟏), a paired release (𝑹𝑹𝟐𝟐 and 𝑹𝑹𝟑𝟑), 

and three downriver hydrophone arrays (shown as dotted lines). At the dam face, a 

3D hydrophone array is used to construct the virtual release of fish known to have 

arrived at the dam. 
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B.2.3.1 Variance Calculations Under Independence 

The variance of 𝑆̂𝑆𝐷𝐷𝐷𝐷𝐷𝐷 can be estimated using a combination of Goodman’s 

(1960) formula for a product of independent estimates and the delta method (Seber 

1982, pp. 7–9), where 

Var�𝑆̂𝑆𝐷𝐷𝐷𝐷𝐷𝐷� = �
1
𝑆𝑆22

+
Var�𝑆̂𝑆2�
𝑆𝑆24

� × 

�𝑆𝑆12Var�𝑆̂𝑆3� + 𝑆𝑆32Var�𝑆̂𝑆1� + Var�𝑆̂𝑆1�Var�𝑆̂𝑆3�� +
(𝑆𝑆1𝑆𝑆3)2

𝑆𝑆24
𝑉𝑉𝑉𝑉𝑉𝑉�𝑆̂𝑆2� (B. 34) 

and estimated by the quantity 

Var� �𝑆̂𝑆𝐷𝐷𝐷𝐷𝐷𝐷� = �
1
𝑆̂𝑆22

+
Var� �𝑆̂𝑆2�
𝑆̂𝑆24

� × 

�𝑆̂𝑆12Var� �𝑆̂𝑆3� + 𝑆̂𝑆32Var� �𝑆̂𝑆1� − Var� �𝑆̂𝑆1�Var� �𝑆̂𝑆3�� +
�𝑆̂𝑆1𝑆̂𝑆3�

2

𝑆̂𝑆24
Var� �𝑆̂𝑆2�. (B. 35) 

B.2.3.2 Variance Calculations Under Homogeneity 

In the case where the joint likelihood for the three release groups is respecified 

to allow for downstream homogeneity in survival and/or capture probabilities, the 

estimates 𝑆̂𝑆1, 𝑆̂𝑆2, and 𝑆̂𝑆3 will no longer be independent. In this case, the delta method 

(Seber 1982) is used to approximate the variance where 

Var� �𝑆̂𝑆𝐷𝐷𝐷𝐷𝐷𝐷� = �
𝑆̂𝑆1𝑆̂𝑆3
𝑆̂𝑆2

�
2

× 

�
Var� �𝑆̂𝑆1�
𝑆̂𝑆12

+
Var� �𝑆̂𝑆2�
𝑆̂𝑆22

+
Var� �𝑆̂𝑆3�
𝑆̂𝑆32

 +
2Covar� �𝑆̂𝑆1𝑆̂𝑆3�

𝑆̂𝑆1𝑆̂𝑆3
−

2Covar� �𝑆̂𝑆1𝑆̂𝑆2�
𝑆̂𝑆1𝑆̂𝑆2

−
2Covar� �𝑆̂𝑆2𝑆̂𝑆3�

𝑆̂𝑆2𝑆̂𝑆3
� (B. 36) 
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B.2.3.3 Variance Calculations when Dam Survival is Calculated Using Closed-
form Estimator 

When 𝑆̂𝑆𝐷𝐷𝐷𝐷𝐷𝐷 is estimated in closed form, using the direct results of the CJS 

model and separate estimates of tag-life probability, then 

𝑆̂𝑆𝐷𝐷𝐷𝐷𝐷𝐷 =
�𝜙𝜙
�1
𝑇𝑇�1
� �𝜙𝜙

�3
𝑇𝑇�3
�

�𝜙𝜙
�2
𝑇𝑇�2
�

= �
𝜙𝜙�1𝜙𝜙�3
𝜙𝜙�2

� �
𝑇𝑇�2
𝑇𝑇�1𝑇𝑇�3

� . (B. 37) 

In this situation, the variance of 𝑆̂𝑆𝐷𝐷𝐷𝐷𝐷𝐷 is based on separate variance 

calculations of the factors �𝜙𝜙�1𝜙𝜙�3/𝜙𝜙�2� and �𝑇𝑇�1𝑇𝑇�3/𝑇𝑇�2� analogously to Equations B.35 and 

B.36, respectively, and then applying Goodman (1960) for the variance of a product. 

B.2.3.4 Virtual Release Group as a Composite 

The virtual release group is composed of fish known to have arrived alive at an 

acoustic array. This group may be composed of individuals from multiple release 

groups upstream. As such, they may have had different times in the river since 

release and require different tag-life corrections. 

Assuming all fish in a virtual release have the same downstream survival and 

detection processes, their subsequent capture histories may be modeled by a 

joint likelihood. Fish from the different release sources would have separate 

likelihoods similar to Equation B.19, but with shared survival and 

capture/detection parameters. Each fish source would have a different set of tag-

life corrections corresponding to their different mean travel times to the detection 

locations. This joint likelihood is of the form 

�𝐿𝐿𝑖𝑖�𝑆𝑆, 𝑝⃗𝑝, 𝜆𝜆�𝑅𝑅�⃗ ,𝑚𝑚��⃗ , 𝑟𝑟, 𝑧𝑧,𝑇𝑇�⃗ �,
𝐺𝐺

𝑖𝑖=1

(B. 38) 

where G is the number of separate release groups contributing to the virtual release 

group. 
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In the subsequent estimation of dam passage survival, Equation B.38 is one 

component of the joint likelihood consisting of releases R1, R2, and R3 (Figure B.2). 

A closed-form estimator of 𝑆̂𝑆1 used in the virtual/paired-release design is of the form 

𝑆̂𝑆1 =
∑ 𝑆̂𝑆1𝑖𝑖𝑅𝑅1𝑖𝑖

𝑇𝑇�1𝑖𝑖
𝐺𝐺
𝑖𝑖=1

∑ 𝑅𝑅1𝑖𝑖𝐺𝐺
𝑖𝑖=1

= �
𝑆̂𝑆1𝑖𝑖𝑊𝑊𝑖𝑖

𝑇𝑇�1𝑖𝑖

𝐺𝐺

𝑖𝑖=1

, (B. 39) 

where 

𝑆̂𝑆1𝑖𝑖 = estimate of survival in the first reach (Figure B.2) for virtual release of fish 

from the 𝑖𝑖th source (𝑖𝑖 = 1,…,𝐺𝐺), 

𝑅𝑅1𝑖𝑖 = number of fish in the virtual release from the 𝑖𝑖th source (𝑖𝑖 = 1,…,𝐺𝐺), 

𝑇𝑇1𝑖𝑖 = tag-life probability for fish from the 𝑖𝑖th source (𝑖𝑖 = 1,…,𝐺𝐺) to the first 

downriver detection site, 

𝑅𝑅1 = ∑ 𝑅𝑅1𝑖𝑖𝐺𝐺
𝑖𝑖=1 , and 

𝑊𝑊𝑖𝑖 = 𝑅𝑅1𝑖𝑖 𝑅𝑅1⁄ . 

The variance of 𝑆̂𝑆1 (Equation B.39) is based on the delta method (Seber 1982), 

treating the 𝑅𝑅1𝑖𝑖 variables as known constants. 

B.2.3.5 Stratification for Different Tag Activation Periods 

Within a release group (i.e., 𝑅𝑅1, 𝑅𝑅2, or 𝑅𝑅3), fish from the same release source 

may have different lag times (delays) between tag activation and fish release. 

Typically, these lag times range in the order of 24 to 48 hours and are 

standardized for all fish. When this is not the situation, a release group may need 

to be stratified into different lag-time subpopulations to account for different 

distributions in time between tag activation and arrival downstream at a detection 

array. 

Assuming the fish in the different strata share common downstream survival 

and detection processes but different tag-life corrections, a release group can be 
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modeled by a joint likelihood similar to Equation B.38. In this manner, different 

distributions for the times between tag activation and arrival can be taken into 

account without undue loss of precision. 

B.2.4 Full Virtual Release/Dead-fish Correction Study Design 

The full ViRDCt study design is used to estimate the probability of dam 

passage survival using a virtual release at the dam face, a dead smolt release in 

the dam tailrace, and two downstream detection sites: one at the tailrace and one at 

the tailwater (Figure B.3).  

 

Figure B.3: Schematic of a Full Virtual Release/Dead-fish Correction (ViRDCt) 

release-recapture design to estimate dam passage survival. 
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Data 

Variable Definition 
𝑉𝑉1 = number of fish in the live virtual release at the 

dam face, 

𝐷𝐷1 = number of fish in the dead release at the dam, 

𝑛𝑛11 = number of 𝑉𝑉1 release fish detected at both tailrace 

and tailwater arrays, 

𝑛𝑛10 = number of 𝑉𝑉1 release fish detected at tailrace 

array but not tailwater array, 

𝑛𝑛01 = number of 𝑉𝑉1 release fish not detected at tailrace 

but detected at tailwater array, 

𝑛𝑛00 = number of 𝑉𝑉1 release fish not detected at either 

tailrace or tailwater array, 

𝑑𝑑11 = number of 𝐷𝐷1 release fish detected at both tailrace 

and tailwater arrays, 

𝑑𝑑10 = number of 𝐷𝐷1 release fish detected at tailrace 

array but not tailwater array, 

𝑑𝑑01 = number of 𝐷𝐷1 release fish not detected at tailrace 

but detected at tailwater array, and 

𝑑𝑑00 = number of 𝐷𝐷1 release fish not detected at either 

tailrace or tailwater array. 

Parameters 

Variable Definition 
𝑆𝑆𝐷𝐷 = probability of dam survival to tailrace array 

conditional on arriving at the dam face, 

𝜔𝜔 = probability of drifting to tailrace array conditional 

on being dead at dam exit, 
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𝑝𝑝1 = probability of detection on tailrace array 

conditional on being alive and arriving at that 

array, 

𝑝𝑝𝐷𝐷 = probability of detection on tailrace array 

conditional on arriving at that array dead, 

𝜆𝜆 = joint probability of a live fish arriving at the 

tailwater array and being detected there, 

conditional on having arrived at the tailwater 

array, 

Ψ = joint probability of a dead released fish (D1) 

arriving at the tailwater array and being detected 

at that array conditional on having arrived at the 

tailrace array, 

𝑇𝑇1𝑉𝑉 = probability of tag survival from dam to tailrace 

array for fish from the (live) virtual release, 

𝑇𝑇2𝑉𝑉 = probability of tag survival from dam to tailwater 

array for fish from the (live) virtual release, 

𝑇𝑇1𝐷𝐷 = probability of tag survival from dam to tailrace 

array for fish from the dead fish release, and 

𝑇𝑇2𝐷𝐷 = probability of tag survival from dam to tailwater 

array for fish from the dead fish release. 

The full ViRDCt model uses unique probabilities of tag survival to the detection 

sites for fish from the live (virtual) release and fish from the dead release. This approach 

allows for different rates of travel or drift based on release group. All fish from the live 

release have the same probability of tag survival regardless of fish survival status. The 

likelihood function is of the form: 

 𝐿𝐿 = �𝑉𝑉1
𝑛𝑛�⃗
� (𝑆𝑆𝐷𝐷𝑝𝑝1𝜆𝜆𝑇𝑇2𝑉𝑉 + (1 − 𝑆𝑆𝐷𝐷)𝜔𝜔𝑝𝑝𝐷𝐷Ψ𝑇𝑇2𝑉𝑉)𝑛𝑛11 

∙ (𝑆𝑆𝐷𝐷(1 − 𝑝𝑝1)𝜆𝜆𝑇𝑇2𝑉𝑉 + (1 − 𝑆𝑆𝐷𝐷)𝜔𝜔(1 − 𝑝𝑝𝐷𝐷)Ψ𝑇𝑇2𝑉𝑉)𝑛𝑛01 
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∙ �𝑆𝑆𝐷𝐷𝑝𝑝1(𝑇𝑇1𝑉𝑉 − 𝑇𝑇2𝑉𝑉𝜆𝜆) + (1 − 𝑆𝑆𝐷𝐷)𝜔𝜔𝑝𝑝𝐷𝐷(𝑇𝑇1𝑉𝑉 − 𝑇𝑇2𝑉𝑉Ψ)�𝑛𝑛10 

∙ �𝑆𝑆𝐷𝐷�(1 − 𝑇𝑇1𝑉𝑉) + (1 − 𝑝𝑝1)(𝑇𝑇1𝑉𝑉 − 𝑇𝑇2𝑉𝑉𝜆𝜆)�

+ (1 − 𝑆𝑆𝐷𝐷)�(1 − 𝜔𝜔𝑇𝑇1𝑉𝑉) + 𝜔𝜔(1 − 𝑝𝑝𝐷𝐷)(𝑇𝑇1𝑉𝑉 − 𝑇𝑇2𝑉𝑉Ψ)��𝑛𝑛00 

∙ �𝐷𝐷
𝑑𝑑
� (𝜔𝜔𝑝𝑝𝐷𝐷Ψ𝑇𝑇2𝐷𝐷)𝑑𝑑11(𝜔𝜔(1 − 𝑝𝑝𝐷𝐷)Ψ𝑇𝑇2𝐷𝐷)𝑑𝑑01 

∙ �𝜔𝜔𝑝𝑝𝐷𝐷(𝑇𝑇1𝐷𝐷 − 𝑇𝑇2𝐷𝐷Ψ)�𝑑𝑑10�(1 − 𝜔𝜔𝑇𝑇1𝐷𝐷) + 𝜔𝜔(1 − 𝑝𝑝𝐷𝐷)(𝑇𝑇1𝐷𝐷 − 𝑇𝑇2𝐷𝐷Ψ)�𝑑𝑑00 . (B. 40) 

There is no closed form estimator of dam passage survival (𝑆𝑆𝐷𝐷) for the full ViRDCt 

model. Variances are estimated using the total variance formula from Equations (B.20) 

– (B.22), using the inverted Hessian matrix to estimate the second term in Equation 

(B.21). 

B.2.5 Reduced Virtual Release/Dead-fish Correction Study Design 

The reduced ViRDCt study design is used to estimate the probability of dam 

passage survival using a virtual release at the dam face and a dead smolt release in the 

dam tailrace. The virtual release requires exactly two downstream detection sites, and 

the dead smolt release requires one downstream detection site (Figure B.4).  
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Figure B.4: Schematic of a reduced Virtual Release/Dead-fish Correction (ViRDCt) 

release-recapture design to estimate dam passage survival. 

Data 

Variable Definition 
𝑉𝑉1 = number of fish in the live virtual release at the dam face, 

𝑧𝑧𝐷𝐷1 = number of fish in the dead release at the dam, 

𝑛𝑛11 = number of 𝑉𝑉1 release fish detected at both tailrace and 

tailwater arrays, 

𝑛𝑛10 = number of 𝑉𝑉1 release fish detected at tailrace array but 

not tailwater array, 

 𝑛𝑛01 = number of 𝑉𝑉1 release fish not detected at tailrace but 

detected at tailwater array, 

𝑛𝑛00 = number of 𝑉𝑉1 release fish not detected at either tailrace 

or tailwater array, 

𝑛𝑛 = number of 𝑉𝑉1 release fish detected at tailrace array, 

𝑚𝑚 = number of 𝐷𝐷1 release fish detected at tailrace array. 
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Parameters 

Variable Definition 
𝑆𝑆𝐷𝐷 = probability of dam survival to tailrace array conditional 

on arriving at the dam face, 

𝑝𝑝1 = probability of detection on tailrace array conditional on 

being alive and arriving at that array, 

ϕ = joint probability of arriving at the tailrace and being 

detected at that array conditional on being dead at dam 

exit, 

𝜆𝜆 = joint probability of a live fish arriving at the tailwater 

array and being detected there, conditional on having 

arrived at the tailwater array, 

𝑇𝑇1𝑉𝑉 = probability of tag survival from dam to tailrace array for 

fish from the (live) virtual release, 

𝑇𝑇2𝑉𝑉 = probability of tag survival from dam to tailwater array 

for fish from the (live) virtual release, 

𝑇𝑇1𝐷𝐷 = probability of tag survival from dam to tailrace array for 

fish from the dead fish release. 

The reduced ViRDCt model uses different probabilities of tag survival to detection 

sites for fish from the live (virtual) release and fish from the dead release. All fish from 

the live release are modeled with the same probability of tag survival regardless of fish 

survival status. 

𝐿𝐿 = �𝑉𝑉1
𝑛𝑛�⃗
� (𝑆𝑆𝐷𝐷𝑝𝑝1𝜆𝜆𝑇𝑇2𝑉𝑉)𝑛𝑛11(𝑆𝑆𝐷𝐷(1 − 𝑝𝑝1)𝜆𝜆𝑇𝑇2𝑉𝑉)𝑛𝑛01 

∙ (𝑆𝑆𝐷𝐷𝑝𝑝1(𝑇𝑇1𝑉𝑉 − 𝑇𝑇2𝑉𝑉𝜆𝜆) + (1 − 𝑆𝑆𝐷𝐷)𝜙𝜙𝑇𝑇1𝑉𝑉)𝑛𝑛10 

∙ �𝑆𝑆𝐷𝐷�(1 − 𝑇𝑇1𝑉𝑉) + (1 − 𝑝𝑝1)(𝑇𝑇1𝑉𝑉 − 𝑇𝑇2𝑉𝑉𝜆𝜆)�

+ (1 − 𝑆𝑆𝐷𝐷)(1 − 𝜙𝜙𝑇𝑇1𝑉𝑉)�𝑛𝑛00 

∙ �𝐷𝐷𝑚𝑚�
(𝜙𝜙𝑇𝑇1𝐷𝐷)𝑚𝑚(1 − 𝜙𝜙𝑇𝑇1𝐷𝐷)𝐷𝐷−𝑚𝑚 (B. 41) 
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Closed Form Estimators 

𝑆̂𝑆𝐷𝐷 =

𝑛𝑛11 + 𝑛𝑛10
𝑉𝑉1

− �𝑚𝑚𝐷𝐷� �
𝑇𝑇�1𝑉𝑉
𝑇𝑇�1𝐷𝐷

�

� 𝑛𝑛11
𝑛𝑛11 + 𝑛𝑛01

− 𝑚𝑚
𝐷𝐷𝑇𝑇�1𝐷𝐷

� ∙ 𝑇𝑇�1𝑉𝑉
 

𝑝̂𝑝1 =
𝑛𝑛11

𝑛𝑛11 + 𝑛𝑛01
 

λ� =

⎣
⎢
⎢
⎡ �𝑛𝑛11𝑉𝑉1

� �𝑇𝑇
�1𝑉𝑉
𝑇𝑇�2𝑉𝑉

�

𝑛𝑛11 + 𝑛𝑛10
𝑉𝑉1

− �𝑚𝑚𝐷𝐷� �
𝑇𝑇�1𝑉𝑉
𝑇𝑇�1𝐷𝐷

�⎦
⎥
⎥
⎤
�1 − �

𝑛𝑛11 + 𝑛𝑛01
𝑛𝑛11

� �
𝑚𝑚

𝐷𝐷𝑇𝑇�1𝐷𝐷
�� 

𝜙𝜙� =
𝑚𝑚

𝐷𝐷𝑇𝑇�1𝐷𝐷
 

where 𝑇𝑇�1𝑉𝑉, 𝑇𝑇�2𝑉𝑉, and 𝑇𝑇�1𝐷𝐷 are the estimates of tag survival probabilities 𝑇𝑇1𝑉𝑉, 𝑇𝑇2𝑉𝑉, and 𝑇𝑇1𝐷𝐷, 

respectively. 

Variance estimators of the closed form estimators can be computed as follows: 

𝑉𝑉𝑉𝑉𝑉𝑉� (𝑝̂𝑝1) =
𝑝̂𝑝1(1 − 𝑝̂𝑝1)
𝑉𝑉1𝑆̂𝑆𝐷𝐷λ�𝑇𝑇�2𝑉𝑉

 

𝑉𝑉𝑉𝑉𝑉𝑉� �ϕ�� =
ϕ��1 − ϕ�𝑇𝑇�1𝐷𝐷�

𝐷𝐷𝑇𝑇�1𝐷𝐷
 

𝑉𝑉𝑉𝑉𝑉𝑉� �𝑆̂𝑆𝐷𝐷� = (𝐴𝐴11)2𝑉𝑉11 + (𝐴𝐴10)2𝑉𝑉10 + (𝐴𝐴01)2𝑉𝑉01 + (𝐴𝐴𝑚𝑚)2𝑉𝑉𝑚𝑚 + 2𝐴𝐴11𝐴𝐴10𝐶𝐶1 + 2𝐴𝐴11𝐴𝐴01𝐶𝐶2
+ 2𝐴𝐴10𝐴𝐴01𝐶𝐶3 

and  

𝑉𝑉𝑉𝑉𝑉𝑉� �λ�� = (𝐵𝐵11)2𝑉𝑉11 + (𝐵𝐵10)2𝑉𝑉10 + (𝐵𝐵01)2𝑉𝑉01 + (𝐵𝐵𝑚𝑚)2𝑉𝑉𝑚𝑚 + 2𝐵𝐵11𝐵𝐵10𝐶𝐶1 + 2𝐵𝐵11𝐵𝐵01𝐶𝐶2
+ 2𝐵𝐵10𝐵𝐵01𝐶𝐶3 

where 
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𝐴𝐴11 =
λ�𝑇𝑇�2𝑉𝑉 − (1 − 𝑝̂𝑝1)𝑇𝑇�1𝑉𝑉
𝑉𝑉1�𝑝̂𝑝1 − ϕ��𝜆̂𝜆𝑇𝑇�1𝑉𝑉𝑇𝑇�2𝑉𝑉

 

𝐴𝐴10 =
1

𝑉𝑉1�𝑝̂𝑝1 − ϕ��𝑇𝑇�1𝑉𝑉
 

𝐴𝐴01 =
𝑝̂𝑝1

𝑉𝑉1�𝑝̂𝑝1 − ϕ��𝜆̂𝜆𝑇𝑇�2𝑉𝑉
 

𝐴𝐴𝑚𝑚 =
−�1 − 𝑆̂𝑆𝐷𝐷�

𝐷𝐷�𝑝̂𝑝1 − ϕ��𝑇𝑇�1𝐷𝐷
 

𝐵𝐵11 =
�1 −ϕ��𝑇𝑇�1𝑉𝑉 − 𝜆̂𝜆𝑇𝑇�2𝑉𝑉
𝑉𝑉1𝑆̂𝑆𝐷𝐷�𝑝̂𝑝1 − ϕ��𝑇𝑇�1𝑉𝑉𝑇𝑇�2𝑉𝑉

 

𝐵𝐵10 =
−𝜆̂𝜆

𝑉𝑉1𝑆̂𝑆𝐷𝐷�𝑝̂𝑝1 − ϕ��𝑇𝑇�1𝑉𝑉
 

𝐵𝐵01 =
−ϕ�

𝑉𝑉1𝑆̂𝑆𝐷𝐷�𝑝̂𝑝1 − ϕ��𝑇𝑇�2𝑉𝑉
 

𝐵𝐵𝑚𝑚 =
�1 − 𝑆̂𝑆𝐷𝐷�λ�

𝑆̂𝑆𝐷𝐷�𝑝̂𝑝1 − ϕ�� ∙ 𝐷𝐷𝑇𝑇�1𝐷𝐷
 

and 

𝑉𝑉11 = 𝑉𝑉1𝑆̂𝑆𝐷𝐷𝑝̂𝑝1λ�𝑇𝑇�2𝑉𝑉�1 − 𝑆̂𝑆𝐷𝐷𝑝̂𝑝1λ�𝑇𝑇�2𝑉𝑉� 

𝑉𝑉10 = 𝑉𝑉1�𝑆̂𝑆𝐷𝐷𝑝̂𝑝1�𝑇𝑇�1𝑉𝑉 − λ�𝑇𝑇�2𝑉𝑉� + �1 − 𝑆̂𝑆𝐷𝐷�ϕ�𝑇𝑇�1𝑉𝑉��1

− �𝑆̂𝑆𝐷𝐷𝑝̂𝑝1�𝑇𝑇�1𝑉𝑉 − λ�𝑇𝑇�2𝑉𝑉� + �1 − 𝑆̂𝑆𝐷𝐷�ϕ�𝑇𝑇�1𝑉𝑉�� 

𝑉𝑉01 = 𝑉𝑉1𝑆̂𝑆𝐷𝐷(1 − 𝑝̂𝑝1)λ�𝑇𝑇�2𝑉𝑉�1 − 𝑆̂𝑆𝐷𝐷(1 − 𝑝̂𝑝1)λ�𝑇𝑇�2𝑉𝑉� 

𝑉𝑉𝑚𝑚 = 𝐷𝐷ϕ�𝑇𝑇�1𝐷𝐷�1 − ϕ�𝑇𝑇�1𝐷𝐷� 

𝐶𝐶1 = −𝑉𝑉1�𝑆̂𝑆𝐷𝐷𝑝̂𝑝1λ�𝑇𝑇�2𝑉𝑉��𝑆̂𝑆𝐷𝐷𝑝̂𝑝1�𝑇𝑇�1𝑉𝑉 − λ�𝑇𝑇�2𝑉𝑉� + �1 − 𝑆̂𝑆𝐷𝐷�ϕ�𝑇𝑇�1𝑉𝑉� 

𝐶𝐶2 = −𝑉𝑉1�𝑆̂𝑆𝐷𝐷𝑝̂𝑝1λ�𝑇𝑇�2𝑉𝑉��𝑆̂𝑆𝐷𝐷(1 − 𝑝̂𝑝1)λ�𝑇𝑇�2𝑉𝑉� 

𝐶𝐶3 = −𝑉𝑉1�𝑆̂𝑆𝐷𝐷(1 − 𝑝̂𝑝1)λ�𝑇𝑇�2𝑉𝑉��𝑆̂𝑆𝐷𝐷𝑝̂𝑝1�𝑇𝑇�1𝑉𝑉 − λ�𝑇𝑇�2𝑉𝑉� + �1 − 𝑆̂𝑆𝐷𝐷�ϕ�𝑇𝑇�1𝑉𝑉� 
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Glossary 

actual single-release study A single-release study in which a single release 

composes the release group.  

attribute group file An optional input file that defines one or more attributes and 

assigns attribute values to each tag code. It allows analysis of a subset of the 

data based on attribute values.  

bin Designates the tag bin; sometimes referred to as “lot.” Tags that come from 

different manufacturing lots may require different tag-life curves to model tag 

failure. Tags may also be grouped into different bins if tag handling issues 

necessitates calculating separate tag-life corrections for some subset of tags 

within a release.  

navigation panel The panel that, by default, occupies the left side of the main 

ATLAS dialog, showing the list of available actions. An action is initiated by 

double-clicking on it.  

release A group of tagged individuals released at the same location, grouped 

under a common name in the capture history data file.  

release group One or more releases grouped together that fill a certain role in a 

given study design.  

status report The status report that by default is on the right side of the Program 

ATLAS main window. It indicates the names of the data files currently 

loaded, the number in each release, the groups configuration, and the sites 

configuration. It also shows which tag-life curve is selected, if any.  

survival probability The probability that a fish transited successfully from one release 

or detection site to the next detection site, whether or not it was detected.  

tag correction The probability that a tag will be alive for a given release at a given 
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detection site.  

TagPro TagPro utility, available at Columbia Basin Research Tools page: TagPro.  

virtual release A release group defined by all tagged individuals, possibly from 

multiple upstream releases, detected at a given site (the virtual site). These 

individuals form a release group for all subsequent downstream detections.  

virtual single-release study A single-release study in which one or more releases is 

used to create a single virtual release.  

virtual site A detection site used to define a virtual release.   

https://www.cbr.washington.edu/analysis/apps/tagproapp
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Acronyms 

CDF cumulative distribution function.  

CJS Cormack-Jolly-Seber (Cormack 1964, Jolly 1965, Seber 1965).  

LRT Likelihood Ratio Test.  

MLE Maximum Likelihood Estimate.  

PDF probability density function.  

ViRDCt virtual release with dead fish correction.   
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